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Getting Started

System Requirements
To use the Eudora Pro Email electronic mail application (hereafter referred to as
Eudora), you must have the following:

• IBM PC or compatible.

• Microsoft Windows 95, or Microsoft Windows NT 4.0 or later.

• Winsock 1.1 API compliant networking package.

• A mail account with an Internet Service Provider, or an Internet-style network
account.

• Access to your mail account via PPP dialup networking using a modem or an
Internet-style network connection.

Installing Eudora
Installing Eudora is simple, and requires very little input—just follow the
instructions below. If you are installing over a previous version of Eudora Pro or
Eudora Light, all of your messages, mailboxes, folders, filters, and options will be
maintained.

To install Eudora, perform the following steps.

Note: During this procedure, a dialog may appear informing you that you will need to
restart your machine after installation and before you can begin using Eudora. If this dialog
appears, be sure to click Yes.

1. Exit any applications you are running including toolbars, memory
management programs, screen savers, and virus protection programs.

2. If you are installing from CD-ROM, insert the CD-ROM into your CD drive.
The Windows 95/NT autoplay feature will cause the Eudora Installer screen
to be displayed. (If the screen is not displayed, double-click on the CD drive
icon.)

If you are installing from a software archive, double-click on it to start the
Setup program. The Installer screen is displayed.
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The Eudora Installer screen

3. To install Eudora, click on the Eudora Pro icon in the Installer screen to put a
checkmark in the checkbox next to the listing, then click the Install button.
Installation begins and the Eudora Pro Welcome screen is displayed.

Note: If you wish to install other software applications that appear in the Installer screen,
you will need to do this separately, after installing Eudora. See the note at the end of this
installation procedure for more details.

4. Read the Welcome screen, then click Next. The Software License Agreement
is displayed.

5. Read the Software License Agreement and if you agree to the terms, click
Yes. (You can also save and/or print the Agreement by selecting its text,
pressing Ctrl+C to copy it to the clipboard, and then pasting it into a text
processing application such as Notepad.)

Note: If you purchased a retail box product of Eudora Pro CommCenter™, then at this point
the installer will search your hard disk for a qualifying previous version of Eudora Pro. If one
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is found, an Upgrade Validation screen will be displayed asking you for your registration
number. You must register your new copy of Eudora Pro, once you have installed it, in order
to get your upgrade rebate.

6. Enter your User Code, then click Next.

Your User Code is printed on the technical support information sheet found
inside the Eudora Pro retail product box, or if you are part of a multi-user
site, it should be provided to you by your company’s e-mail (electronic mail)
administrator. If you purchased Eudora by electronic distribution, the User
Code is in the message you received when you purchased the product.

7. Select the items you wish to install by checking the boxes to the left of each
item, then click Next.

QUALCOMM’s PureVoice™ voice-messaging software lets you record,
send, receive, and play voice messages with your e-mail.

Apple’s QuickTime™ for Windows gives you enhanced viewing of
multimedia in your e-mail messages, and is recommended. If you already
have QuickTime installed on your system and you do not wish to overwrite
it, uncheck the box.

The HTML viewer gives you enhanced viewing of richly formatted text and
multimedia in e-mail messages, and is recommended. Installing this viewer
will not affect your current default Web browser. If you already have
Microsoft’s Internet Explorer 3.0 or later installed on your system, or if you
do not wish to install the HTML viewer, uncheck the box.

8. Specify a directory in which to install Eudora Pro, then click Next.

Note: If you are installing Eudora over your current version of
Eudora Pro or Eudora Light, select your current Eudora
directory. If you are installing Eudora for the first time, you
can select any directory you want.

9. Verify that the displayed settings are correct, then click Next (or use the
Back button if you need to go back and make changes).

10. Eudora is installed in the destination directory. If you elected to install Apple
QuickTime for Windows, the QuickTime Software License Agreement is
displayed. Click Agree and then follow the instructions in the QuickTime
installation dialogs.

11. When all installation is complete, you are prompted for whether or not you
want to view the Eudora README file. Click Yes if you wish to view the
README.
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Note: If you wish to install any other software applications listed in the Eudora Installer
screen, you must do this separately. After installing Eudora, repeat step 2 in the procedure
above, and when the Installer screen displays, click on the icons for the additional software
applications you wish to install. (When you click on an item, a description of the item is
given in the information window.) Now click Install and the installer will install the items
you have selected.

Uninstalling Eudora
You can uninstall Eudora by using the tools provided with your Windows 95 or
Windows NT 4.0 (or later) operating system. Open the Control Panel, double-
click on Add/Remove Programs, select Eudora Pro, and click Remove.

Opening and Configuring Eudora
After you have installed Eudora (and restarted your machine if necessary),
double-click on the Eudora icon to open it. If you are installing Eudora for the
first time, the New Account Wizard opens, showing the welcome screen. Click
Next to begin setting up your new e-mail account.

Select the method of setting up your account. You can either create a brand new
e-mail account, import settings from an existing e-mail account, or instruct
Eudora to attempt to get your settings from an ACAP server. (To get your settings
from an ACAP server, make sure you are connected to the Internet.)

If you choose the ACAP option and click Next, the Auto Configure panel is
displayed. Click Next again to instruct Eudora to try to get your account settings
from the ACAP server. If the attempt fails, click Back and try one of the other
options.

If you choose to import settings from an existing e-mail account, and you select
the account and click Next, Eudora asks you to confirm the settings and
optionally change them. If you select No and click Next, your account is set up
when you click Finish in the final screen. If you select Yes and click Next, the
wizard walks you through the fields to be changed, as described further below.
When you click Finish in the final panel, your new account is set up.

If in the Account Setup panel you choose to create a brand new e-mail account
and click Next, the New Account Wizard begins walking you through the fields
for which you need to enter setup information.

You will need to supply the following items in the panels of the New Account
Wizard (click Next after filling out each panel):
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• Your Name — Enter your name as you would like it to appear in the From
field of all of your outgoing messages from this e-mail account, indicating to
your recipients who the mail is from.

• Return Address — Enter the e-mail address that has been assigned to you by
your Internet Service Provider or your organization’s e-mail administrator. This
is the address that other people will use to send you e-mail. Return addresses
are generally of the form loginname@domainname, and
beatrixp@qualcomm.com is an example.

• Login Name — Enter the name that you will use to log in to this e-mail
account, if the account requires a user login. This name is provided by your
Internet Service Provider or your organization’s e-mail administrator, and it
usually consists of the text that appears before the at sign (@) in your return
e-mail address. In the example beatrixp@qualcomm.com, the login name is
beatrixp.

• Incoming E-mail Server — All of your incoming e-mail messages are
delivered to your incoming e-mail account, which resides on a computer that
runs your incoming e-mail server. Once your messages arrive at your mail
account, Eudora picks them up and transfers them to your PC. Your incoming
e-mail server must use one of the two Internet-mail communications protocols
POP (Post Office Protocol) or IMAP (Internet Message Access Protocol). If
you are not sure which protocol it uses, select POP: you can always change this
later. In the edit box, type the full name of the computer that runs your
incoming e-mail server: bunnies.qualcomm.com is an example.

• If you chose IMAP in the previous setup panel, an IMAP Mailbox Location
Prefix may be required to indicate the location of your personal mailboxes on
the IMAP server. If so, enter the name of that location prefix as given to you by
your Internet Service Provider or e-mail administrator. If the information is not
required, leave the field blank. Now click Next. When you click Finish in the
final panel, your new IMAP e-mail account is set up.

If you chose POP in the previous setup panel, click Finish in the final panel
and your new POP e-mail account is set up.

Once you have completed setting up your account via the New Account Wizard,
you are now ready to receive messages. However, you may need to take an
additional step in order to send messages.

To send messages in Eudora, you must have access to a computer running an
SMTP (Simple Mail Transfer Protocol) server. Your outgoing messages are sent
to the SMTP server, which delivers them to your recipients.
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If the computer that runs your POP or IMAP server (incoming e-mail account)
also runs an SMTP server, then no additional setup action is required. You are
now ready to send and receive messages in Eudora.

If, however, your SMTP server runs on a different computer from the one running
your POP or IMAP server, then take the following final setup action (you may
want to consult your Internet Service Provider or e-mail administrator to help you
set up the SMTP server):

Select Options... from the Tools menu and click on the Sending Mail category.
In the SMTP server field, enter the full name of the computer that runs your
SMTP server (example: mysmtp.qualcomm.com). Then click OK to save your
setting and close the Options dialog. You are now ready to send and receive mail
in Eudora.

For detailed explanations of all of Eudora’s available functions, see the
appropriate chapters of this User Manual, and also see the Eudora Reference
Manual.

If you ever wish to change the settings of your e-mail account, you can do so from
the Options dialog. See the section “The Options Dialog” in the Eudora Reference
Manual.

You can also change these settings in the Account Settings dialog, which is
accessed from the Personalities window. This window also lets you create
alternate e-mail accounts and edit the settings in those accounts. For more details,
see the sections “Using an Alternate E-mail Account,” “Personalities Window,”
and, in that section, “Account Settings Dialog”—all in this User Manual.

Tip of the Day
Each time you open Eudora (including the first time after install), the Eudora Tip
of the Day dialog is displayed, showing you the Tip of the Day. You can display
next and previous tips by clicking the Next Tip and Previous Tip buttons. To
prevent the Tip of the Day dialog from being displayed on startup, uncheck the
Show Tips at Startup checkbox. You can always display the Tip of the Day from
the Help menu.

Click the Close button to close the Tip of the Day dialog.

Quitting Eudora
To quit Eudora, select Exit from the File menu, or press Ctrl+Q. If you have
queued messages, or timed messages due to be sent in the next 12 hours, you are
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given the option to send them (see the sections “Queueing a Message to Send
Later” and “Queueing a Message to Send at a Certain Time”).

The Trash mailbox is emptied if the Empty Trash when exiting option is on in
the Miscellaneous Options.

Online Help
There are several ways to get online Help with Eudora:

• To find out what something in the user interface does, use either Context
Sensitive Help from the Help menu, or the Help button on the main toolbar
(question-mark-and-arrow icon), and click on the item you want to know about.
A brief description of the item is displayed. Click anywhere to close the
description window.

• The F1 key also displays context-sensitive Help. Select the user interface item
you want to know about, or use the Tab and arrow keys to move keyboard
focus to that item, then press F1. (Keyboard focus is indicated by a dashed
highlight box, a highlighted entry or item, or a flashing insertion cursor.)

• For instructions on how to do certain tasks, select Topics from the Help menu.
The Help Contents are displayed, and you either browse the contents or use the
Find and Index options.

• The Eudora Tip of the Day provides snapshot information on assorted Eudora
features. The Tip of the Day dialog is displayed each time you start up Eudora,
and can also be displayed from the Help menu. See the section “Tip of the
Day.”

Registering Your Copy of Eudora
Depending on the software license you have for Eudora, you may be eligible for
technical support directly from the Eudora Technical Support group. To receive
technical support, you must register your copy of Eudora Pro in accordance with
the terms defined in your license Agreement. If you have a previous version of
Eudora Pro, you need to register this new version.

Note: If you are part of a site license, you do not need to register. Contact your
organization’s e-mail administrator for support.

If you are eligible for technical support, you are prompted to register after you
send the first message with your new version of Eudora Pro. Complete the
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registration form and click Register. The registration is put in the queue in your
Out mailbox and is sent the next time you send queued messages.

If you don’t want to register at that time, you can choose Not Now to be prompted
7 days later, or Never Register to never be prompted again. At any time, you can
choose Register Eudora... from the Help menu to display the registration form.

Technical Support
If, after reviewing all of the available materials, you are still in need of assistance,
contact your e-mail administrator (your Internet Service Provider or your
company’s Eudora support coordinator) or the Eudora Technical Support group. If
you are eligible for technical support, select Technical Support from the Help
menu for contact information, or see the technical support information sheet
found inside the product box.

You must register your copy of Eudora Pro to receive technical support. See the
section “Registering Your Copy of Eudora” for details.
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Creating an Outgoing Message
An outgoing message is a message you send to someone else. The simplest way to
create an outgoing message is to select New Message from the Message menu. A
new message window is displayed, called the composition window.

Using the Composition Window
The composition window consists of the title bar, the Toolbar, the message
header, and the message body.

The composition window

Title Bar
The title bar provides information about the message, including the name of the
addressee, the time and date the message was sent, and the message subject.
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Toolbar
The toolbar consists of a series of buttons and popups that are displayed just under
the title bar. It allows you to control the priority of your message, override some
of your default options for the current message, send or queue the message, and
apply text styles. Each button can be turned on or off for the current message by
clicking on it (a button is on when it is depressed, and off when it is raised). You
can set some of the defaults for the toolbar in the Sending Mail Options.

The popup menus and buttons on the top row are described below.

Priority Popup
This lets you indicate that your message is of higher or lower priority
than a normal message. For most messages, this is just an empty box
(normal priority). For details, see the section “Setting the Message
Priority.”

Signature Popup
This lets you automatically append one of your signatures to the end of a
message. For details, see the section “Using a Signature.”

Attachment Type Popup
This lets you select the encoding format for attachments. For details, see
the section “Attaching a File to a Message.”

Quoted-Printable Encoding
If this is on, quoted-printable encoding is used when sending messages
that contain special characters or long lines of text. It is used for all
plain-text attachments. We recommend that you always keep this on.

Text As Attachment
If this is on, plain text files are attached to messages, not incorporated
into the message as part of the message body.

Word Wrap
If this is on, a carriage return is not required at the end of each line.
When the message is sent, the text is automatically “wrapped,” meaning
that carriage returns are inserted at the end of each line of text, with
roughly 76 characters per line.

Tabs in Body
If this button is on, pressing the Tab key within the message body inserts
a tab. If this button is off, pressing the Tab key within the message body
returns the cursor to the To field of the message header.
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Keep Copy
If this is on, a copy of each sent message is kept in the Out mailbox.
These messages are saved there until they are deleted or transferred.

Return Receipt
If this is on, the message to your recipients includes a Notify Sender
button that when clicked creates a message notifying you that the
original message was viewed. This function does not work in all cases.
For details, see the section “Requesting a Return Receipt.”

Send or Queue
These let you send a message immediately or put it in the queue to send
later. If the Immediate Send option in the Sending Mail Options is on,
the button is labeled Send. If the option is off, the button is labeled
Queue. For details, see the section “Sending or Queueing a Message.”

Following are descriptions of the popup menus and buttons on the bottom row.
Note that this bottom row of the toolbar, which controls text styles and other
attributes, also appears in text file windows and signature windows.

Font Popup
Make the selected text the selected font (typeface).

Size
Make the selected text the selected size.

Bold
Make the selected text bold.

Italics
Make the selected text italic.

Underline
Make the selected text underlined.

Color
Make the selected text the selected color.

Typewriter
Make the selected text the fixed-width (typewriter-style) message font
set in the Fonts Options.
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Align Left
Make the selected paragraph aligned to the left of the indent.

Align Center
Make the selected paragraph aligned to the center of the indent.

Align Right
Make the selected paragraph aligned to the right of the indent.

Indent In
Make the selected paragraph indented once to the left.

Indent Out
Remove one left indent for the selected paragraph.

Bulleted List
Make the selected text a bulleted list.

Make Hyperlink
Make the selected text or graphic a clickable hyperlink to a URL, so that
when the recipient clicks the item, he or she is immediately taken to the
URL.

Clear Formatting
Removes all the formatting from the selected text or paragraph.

Insert Object
Insert a specified picture (JPEG graphic file) or a horizontal line at the
current cursor position in body text. For details, see the section
“Inserting Objects in Message Text.”

For more information on text styles, see the section “Formatting Text.”

Message Header
Outgoing mail headers consist of six fields: To, From, Subject, Cc, Bcc, and
Attached. Each field is described below. The To, Subject, Cc, and Bcc fields can
be directly edited. To move the cursor from field to field, press the Tab key or
click in the desired field with the mouse.
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To resize the Header region of the outgoing message window, drag the separator
up or down. This applies to the current message only.

To
The intended recipients’ e-mail addresses, or nicknames you have defined (see the
section “Using the Address Book and Quick Recipient List”). Multiple addresses
and nicknames must be separated by commas.

From
The sender’s e-mail address. This is usually your incoming e-mail account plus
your real name. You can use a return address other than your incoming mail
account by entering the address in the Return address field of the Getting Started
Options.

The From field also reflects changes made with the Change Personality menu
under the Message menu, if you have alternate personalities set up. See the
section “Using an Alternate E-mail Account.”

Subject
Some brief text indicating the contents of the message. This field can be left
blank, although it is considered a point of e-mail etiquette to include a Subject
with each message.

Cc
The e-mail addresses or nicknames of people to whom a copy of the message is to
be sent. These recipients are displayed in the message header for all recipients to
see. Multiple addresses must be separated by commas. This field can be left
blank. Cc stands for “carbon copy.”

Bcc
The e-mail addresses or nicknames of people to whom a blind copy of the
message is to be sent. These recipients are not displayed in the message header,
and the recipients in the To or Cc fields will not know that a copy went to these
addresses. This is useful when you want to send a copy of a message to someone
without everyone else knowing you did so. Multiple addresses must be separated
by commas. This field can be left blank. Bcc stands for “blind carbon copy.”

This field can also be used to put a copy of the message in one or more of your
mailboxes. To do this, right-click in the body of the message and select the
mailbox from the Fcc menu (equivalent to the Transfer menu). The name of the
mailbox is inserted into the Bcc field preceded by the expression “ƒ\.” Repeat the
procedure to Fcc to multiple mailboxes; Eudora automatically separates the
entries with commas. When the message is sent, a copy is put in each specified
mailbox. Fcc stands for “folder carbon copy.”
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Attached
A list of documents being attached to and sent along with the message. See the
section “Attaching a File to a Message” for instructions on how to add
attachments. To delete an attachment from an outgoing message, select it and
press the backspace or delete key. This field can be left blank.

Message Body
After filling in the header fields, move the insertion point to the space below the
message header. Type the body of the message here. For information about
formatting your message text, see the section “Formatting Text.” Also see the
“Toolbar” section above.

You can insert pictures (JPEG graphic files) and horizontal lines into message
text. For details, see the section “Inserting Objects in Message Text.”

Using an Alternate E-mail Account (Multiple Personalities)
You can set up alternate “personalities” in Eudora for each e-mail account you
have. For example, if you have Work, Home, and School e-mail accounts, you
can set up Eudora to send and receive e-mail from each of these accounts, all
without having to quit and restart Eudora. That is, you can check mail for all your
accounts at once, or for selected accounts at once, and you can do the same for
sending mail.

In earlier versions of Eudora you specified the setup information for these
different e-mail accounts, or “personalities,” in the Personalities Options. In
Eudora 4.0, you use the Personalities window and the Account Settings dialog.
Your “dominant” personality, or principal e-mail account, is set up via the New
Account Wizard when you install Eudora, and can also be modified via the
Account Settings dialog.

For detailed information on the Personalities window, its columns, the commands
on its context menu, and the options in the Account Settings dialog, see the
section “Personalities Window.” Below is the basic procedure for setting up
alternate accounts, followed by additional information on using personalities to
send and receive mail.

To create a new personality, or alternate e-mail account, perform the following
procedure:

1. Open the Personalities window: select Personalities from the Tools menu, or
click the Personalities window’s tab if it is the inactive window in a tabbed
group.
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2. Right-click anywhere inside the Personalities window and select New... from
the context menu. The first panel of the New Account Wizard displays.

3. Follow the setup instructions in each panel of the New Account Wizard to
create the new personality. See the section “Personalities Window” for more
information.

4. When you have completed the new account setup, click Finish and the new
personality is created.

During new account setup you specify the personality name and the following
items associated with the account: the real name, the return e-mail address, the
login name, and the incoming e-mail server (POP or IMAP).

To modify an existing personality, open the Personalities window, right-click on
the desired personality to display the context menu, select Modify... and then
make your changes in the Account Settings dialog. For more information, see the
section “Account Settings Dialog.”

All options other than those specified in the New Account Wizard or the Account
Settings dialog cannot be changed for alternate personalities—they are effective
for all. If you want to change other options for an alternate personality, or use a
separate set of mailboxes for an account, see the section “Putting Multiple Users
on One PC” in the Eudora Reference Manual.

To create an outgoing message from an alternate account—i.e., as an alternate
personality—open the Personalities window, right-click on the desired personality
to display the context menu, and select New Message As from the Message
submenu. Or, select the desired personality and press Enter. Or, simply double-
click on the desired personality. A new message opens from that personality.

A fourth way to create an outgoing message as an alternate personality is this:
Hold down the shift key and select one of the message creation commands from
the Message menu (New Message, New Message To, etc.). The Message
Options dialog is displayed.
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The Message Options dialog

Note: The New Message With and Reply With commands will not display the Message
Options dialog. If you want to open a stationery message with an alternate personality, use
one of the other message creation commands to display the Message Options dialog.

Select the personality you want to use (and stationery if you want to), then click
OK. A composition window is displayed, with the alternate personality as the
sender (and any stationery text if applicable).

When the composition window opens in response to any of the four message-
creation methods above, the default signature for the selected personality is used.
But if a stationery file was selected or a default stationery file specified in the
account’s options, then the signature stored with the stationery file is used.
However, you can always change the signature popup in the composition window
(for details, see the section “Using a Signature”).

Once you open a new composition message from a particular personality, you can
also change the message’s personality (i.e., the sender) by selecting the new
personality from the Change Personality submenu under the Message menu. The
From field of the message header changes to the information associated with the
new personality.

When you respond to a message, Eudora assigns your response the same
personality under which it received the message. For example, if you receive a
message sent to your Home account, your replies to that message are sent from
your Home account.

There are two ways to change the personality of a response. The first is to initiate
the response and then change the personality, using the Message menu Change
Personality submenu.

The second way is to change the personality associated with the original message
to which you are responding. Open that message and change its personality using
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the Change Personality submenu. From then on, all of your replies to that
message will be sent from the newly assigned personality.

Note: You can also set up a filter to automatically assign a desired personality to incoming
or outgoing messages that satisfy the filter criteria. See the Make Personality action under
the section “Filter Actions.”

Using Stationery
Stationery files are templates for outgoing messages. If you find yourself
repeatedly sending the same message, save the message as a stationery file and
send it whenever you need to with the New Message With or Reply With
commands. This way you don’t have to copy and paste text into a message: you
can just open a pre-written message and edit it as necessary.

Stationery files are created and managed from the Stationery window. For more
information, see the section “Stationery Window.” You can also open a new
stationery message from the Stationery window.

Below is the basic procedure for creating a new stationery file in the Stationery
window, followed by additional information on creating and sending stationery
messages.

To create a new stationery file, do the following:

1. Open the Stationery window: select Stationery from the Tools menu, or click
the Stationery window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Stationery window and select New... from the
context menu. Eudora opens a composition window to be used for stationery.
The Send/Queue button is inactive in the window; thus the message cannot be
sent or queued.

3. Put the text you want into the message body, fill in the headers as appropriate
(subject, copies, etc.), and set the Toolbar.

4. Select Save As Stationery from the File menu to display the Save as
Stationery dialog.

5. Enter a file name and click Save to save the stationery file. The file is saved to
your Stationery folder.

6. Close the stationery message.

To change a stationery file, right-click on the stationery item in the Stationery
window and select Edit from the context menu, then make your changes and save
them with the Save As Stationery command from the File menu.
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To delete a stationery file, select the desired item in the Stationery window and
press the delete key; or right-click on the stationery item and select Delete from
the context menu. In either case you are prompted to confirm the delete.

To send a stationery message, select a stationery file from the New Message With
or Reply With submenus from the Message menu. A composition window is
displayed containing the header and body from the stationery file. If you are
replying to a message, the stationery information is added to the reply. You can
edit and send this new message just as you would any other message.

You can also send a new stationery message by double-clicking on a stationery
item in the Stationery window, or by selecting the stationery item and pressing
Enter. In either case a new composition window opens containing the selected
stationery.

To use a particular stationery file for all of your outgoing messages, select a
stationery from the Stationery popup in the Sending Mail Options (for your
dominant account only), or in the Account Settings dialog (for any of your
personalities). Most new messages use this file, unless you create the message
using the Redirect, Send Again, New Message With, or Reply With command.

You can also set up a filter to reply with a stationery message. See the section
“Filtering Messages” for more information.

Using a Signature
A signature is a few lines of text that are automatically added to the end of an
outgoing message when it is sent. A signature can be whatever you want, but it is
mostly used to give contact information (telephone, address, etc.). You only use
one signature at a time in a message, but you can create as many different
signatures as you want.

Note: Your signature is not displayed in the Eudora message window, but is added to the
end of the message when it is sent.

Signatures are created and managed from the Signature window. For more
information, see the section “Signature Window.”

Below is the basic procedure for creating a new signature in the Signature
window, followed by additional information on managing signatures and sending
them with messages.

Eudora comes with a default signature called Standard. This is an empty
signature file that you fill with signature text. Instructions for editing signature
files appear after the procedure below.
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To create a new signature, do the following:

1. Open the Signature window: select Signatures from the Tools menu, or click
the Signature window’s tab if it is the inactive window in a tabbed group.

2. Right-click anywhere inside the Signature window and select New... from the
context menu. Eudora displays the Create New Signature dialog, asking you
for a name.

3. In the dialog, enter a signature name and click OK. A signature window is
displayed.

4. Enter your signature text in the signature window. You can format the text
with styles: see the section “Formatting Text.” Also see the “Toolbar” section
above.

Creating a new signature

5. Save the signature file using the File menu Save command.

6. Close the signature window.

To change a signature file, right-click on the signature in the Signature window
and select Edit from the context menu. The signature window is displayed for that
signature. Make any changes you want, save the file with the File menu Save
command, and close the window.

To delete a signature file, select the desired item in the Signature window and
press the delete key; or right-click on the signature item and select Delete from
the context menu. In either case you are prompted to confirm the delete.

To include a particular signature in an outgoing message, select the signature you
want from the Signature popup on the message toolbar.
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Setting the signature for a particular message

To include a particular signature in all of your outgoing messages—unless you
are using stationery—select a signature from the Signature popup in the Sending
Mail Options (for your dominant account only), or in the Account Settings dialog
(for any of your personalities). You can change this for a particular message by
selecting a different signature or None from the Signature popup on the message
toolbar.

Note that if you open a new composition message with stationery, or if you have
default stationery set for all new messages, then the signature stored with that
stationery file is the one used with the new message, overriding any default
signature. However, you can always make the final decision about what signature
to send with a new message by choosing it from the Signature popup on the
message toolbar. For more information on stationery, see the section “Using
Stationery.”

Setting the Message Priority
You can assign a priority to incoming and outgoing messages. The priority is only
for you and your recipients—it does not affect the way mail transport systems
handle the messages.
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There are five priority levels available, 1 being the highest, 5 being the lowest.
Each is represented by a small symbol in the Toolbar of a message window and
the Priority column of a message summary. Priority 3 (Normal) is used for
messages that have no assigned priorities, and it is not displayed. The Highest
priority symbol, a double-caret, is red; the Lowest priority symbol, an inverted
double-caret, is blue.

New messages are created with a Normal priority. To change the priority of the
current message, use the Priority popup.

Changing the priority of a message using the Priority popup

Note: To set up Eudora to always use the sender’s priority on your replies, turn on the Copy
original’s priority to reply option in the Replying Options. You can always change the
priority in the message window.

Requesting a Return Receipt
You can request that your recipients notify you when they have seen your
message. To do this, click on the Return Receipt button (RR) in the message
toolbar.

When your recipients open the message and then close it, a dialog is displayed
asking them to create a notification message now, later, or never (if you sent
yourself a copy of the message, you will see the notification request). If a
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recipient chooses to create a notification message, it is sent to you and tells you
when the recipient displayed your message.

A request for notification

If you receive a request for notification, click Now to queue the notification
message in your Out mailbox: it will be sent the next time queued messages are
sent. Click Later to close the message without sending a notification; however,
each time you open the message and then close it (or if you try to delete it), the
notification request will appear until you click either Now or Never. Click Never
to cancel the notification request without ever sending a notification message.
Click Cancel to dismiss the notification request from the screen while the return
receipt message is open; however, if you close the message, the notification
dialog is displayed again.

The Return Receipt options may or may not work as described, depending on
your recipients’ e-mail software.

Formatting Text
You can use standard text-editing options to format the text of your outgoing
messages, your text files, and your signatures. The formatting is delivered to your
recipients using text-editing standards in common use today, which means that the
formatting your recipient sees depends on how well their e-mail package supports
these standards.

It’s important to remember that you cannot completely control what happens on
your recipient’s computer. Depending on the type of computer they are using,
their installed fonts, their options or preferences, etc., they could end up viewing
something different from what you had intended. Also, the formatting changes
you make are sent to your recipient, but your default text settings are not. Any text
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that you did not make changes to is displayed using your recipient’s default text,
which may be different from yours.

Two Eudora options let you specify how you want to send and receive styled text.
If the Discard styles before sending messages option is on in the Miscellaneous
Options, you will not be able to format your text at all (this option is off by
default). If you want to send styled text, then turn off the Discard styles before
sending messages option, and if you also want to be alerted before sending the
message, then turn on the Warn me when I Queue a message with styled text
option in the Extra Warnings Options.

Text in outgoing messages, text files, and signature files can be formatted using
the commands on the Edit menu Text submenu and using the formatting toolbar.
The Text submenu commands are described below. See the “Toolbar” section
above for information on using the formatting part of the toolbar.

Text Editing Menu Commands
To format text, use the commands on the Text submenu of the Edit menu. If text
in the message body is selected, the menu command applies the formatting to that
text. If no text is selected but the cursor is in the message body, then the font-
related commands apply the formatting to the next text you type, and the margin-
related commands apply the formatting to the current paragraph—the paragraph
containing the cursor.

The formatting options are as follows:

Plain, Bold, Italic, Underline
Make the text plain (the default), bold, italic, or underlined.

Typewriter
Set the text to the fixed-width (typewriter-style) message font selected in the
Fonts Options.

Size
Make the text the selected size: Very Small, Small (the default), Medium, Large,
Larger, Very Large, and Humongous. The increase or decrease is based on the
next or previous standard point size.

Remember that you are viewing the text based on your default settings in the
Fonts Options, but your recipient’s settings and fonts will be different. For
example, if your recipient’s default font size is larger than yours and you send a
message with text set to “Humongous,” your recipient will see text even more
humongous than yours.
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Color
Make the text black or the selected color.

Font
Make the text a certain font by choosing from the fonts available on your system.
Remember that your recipient may not have the same fonts.

Margins—Normal
Make the selected or current paragraph’s left margin normal—i.e., flush left (the
default).

Margins—Indent In, Indent Out
Indent the selected or current paragraph’s left margin in one level, or “outdent”
the left margin: remove one level of indent.

Left, Right, Center
Align the selected or current paragraph to the left, the right, or the center of the
current indent.

Bulleted List
Convert the selected text to a bulleted list, or begin a bulleted list at the insertion
point.

Make Hyperlink
Convert the selected piece of text, or the selected graphic, to a clickable,
underlined hyperlink to a URL you specify: when your recipient clicks the
hyperlink, he or she is immediately taken to the URL.

Clear Formatting
Clear all formatting and go back to the default settings.

Other Formatting Options
If you turn on the Word Wrap button in the message toolbar, then when the
message is sent, carriage returns are automatically inserted at the end of each line
of text, with roughly 76 characters per line. This makes the message legible on
your recipient’s computer.

It is a good idea not to include your own carriage returns within paragraphs if you
have the Word Wrap option turned on. Only use carriage returns to create new
paragraphs in the message.

To manually wrap text, select the text you want, then select Wrap Selection from
the Edit menu. To unwrap text, select the text you want, then hold down the Shift
key and select Wrap Selection from the Edit menu.
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To copy wrapped text without taking the carriage returns (i.e., to copy and
unwrap), hold down the Shift key and select Copy from the Edit menu.

Inserting Objects in Message Text
Use the Insert submenu under the Edit menu to insert pictures (JPEG graphic
files) and horizontal lines into the body of a message. You can also do this using
the Insert Object button on the message toolbar.

You can insert an object in the middle of a line of text or between lines of text in
the message body.

To insert a picture in message text, put the cursor where you want the picture and
select Insert Picture... from the Edit menu. In the dialog that displays, select an
image file and click Open. (The selected file must be a JPEG file.) The picture is
inserted into the message body at the cursor position. You can continue typing
text. Once the picture is inserted in your message, you can drag it to where you
want it in the message. When your recipient opens your message, he or she will
see the picture right in the message body. Note, however, that what your recipient
sees may depend on whether or not the receiving computer and e-mail package
supports the display of inline images embedded in message text.

To insert a horizontal line in message text, put the cursor in the message body,
then select Insert Horizontal Line from the Edit menu. A horizontal rule is
inserted immediately above the line on which the cursor resides.

Attaching a File to a Message
Any file can be attached to and sent with a Eudora message. Most of the time, an
attached document functions like a “rider” to the e-mail message, and does not
appear within the message text. Instead, the name of the document is displayed
automatically in the Attached field of the message header.

To attach a file to an outgoing message, select Attach File [to New Message]
from the Message menu. The Attach File dialog is displayed. Locate the file you
want, select it, and click on the Open button to attach the document to the current
message, or to open a new message with the file attached. You can add as many
attachments as you want to a message.

You can also drag one or more files from either the Desktop or the File Browser
window onto the message window to attach them. (See the section “File Browser
Window.”)
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To detach an attached document before the message is sent, select the document
in the Attached field, then press either the Backspace key or the Delete key.

When the message is sent, if the chosen document is not a plain text (ASCII) file,
it is encoded in the selected attachment type. This allows you to send any kind of
document through the mail, even applications.

If the document is an ASCII file, you can put it in the body of the message by
turning off the Text as Attachment button in the message toolbar, or by turning
on the Put text attachments in body of message option in the Attachments
Options. The toolbar button applies to the current outgoing message; the
Attachments option applies to all outgoing messages.

The attachment types include the following:

MIME
This is best for recipients with MIME-compliant e-mail readers, regardless of
what operating system they are using. For more information on MIME, see the
section “MIME and Mapping” in the Eudora Reference Manual.

BinHex
This is best for recipients on a Macintosh with an e-mail reader that is not MIME-
compliant.

Uuencode
This is best for recipients using PC or Unix systems that are not MIME-
compliant.

Manually Decoding Attachments
If you send an attachment and your recipient’s e-mail program does not
automatically decode it, it will probably be included in the body of the message in
the chosen attachment format (MIME, BinHex, or Uuencode).

If you receive a large message consisting largely of indecipherable text, it is
probably an attachment that was not automatically decoded. Usually this is
because the attachment headers are formatted incorrectly.

To decode an attachment that was not automatically decoded, open the message
and select Save As... from the File menu to save the message as a text file. Then
run the decoding utility appropriate for the encoding method that the sender used.
Decoding utilities can be found at various shareware sites on the Internet.
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Including a URL in a Message
To include a hot link in a message—also known as a URL, for Uniform Resource
Locator—enclose it with less than and greater than signs (angle brackets) to
ensure that your recipient’s e-mail application can identify it as a URL. For
example, <http://www.eudora.com>.

A URL in an outgoing message

Creating a Hyperlink in a Message
Eudora lets you create a hyperlink in an outgoing message: that is, convert a piece
of text, or a graphic, into a link to a URL so that when your recipients click on the
text or graphic, their browser opens and takes them to that URL.

To create a hyperlink, first type the text you want to link in your outgoing
message, then select the text to highlight it. Or, insert a JPEG graphic file using
the Insert Picture... command under the Edit menu, and select the inserted
graphic. Now either select Make Hyperlink from the Text submenu under the
Edit menu, or click the Make Hyperlink button on the message toolbar. In the
URL field of the Hyperlink dialog, enter the full address of the URL (e.g.,
http://www.eudora.com) and click OK. The text or graphic is now linked and is
highlighted and underlined in the message. When your recipient receives the
message, opens it, and clicks on the hyperlink, their browser or other application
will open and go directly to the URL you specified.
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Checking Your Spelling
Eudora includes a built-in spelling checker. It can be used to check for
misspellings in the body of current message composition windows, text files, and
signature files. It includes a built-in dictionary and also allows for the creation of
a custom user dictionary. Additionally, it can be configured to ignore capitalized
words, words with all capitals, words with numbers, and mixed-case words; to
report doubled (repeated) words; and to suggest alternative spellings.

Note: Changes to the spelling options can be made in the Options dialog (Spell Checking
category) or by selecting Options from the Check Spelling dialog.

See the “Sources” section of the Eudora Reference Manual for information on
how to get dictionaries for languages other than U.S. English.

To automatically check spelling when you send or queue a message, turn on the
Check when message queued/sent option in the Spell Checking Options. If this
is on, then when you send or queue a message, the message is checked for
spelling errors. If you complete the spell-checking process, the message is
automatically sent or queued. If you instead click Cancel, or leave spelling errors
in the message, a dialog is displayed asking you if you still want to send or queue
the message. If you don’t want that dialog to be displayed, turn on the Don’t
warn me anymore option (this can also be set in the Spell Checking Options).

Note: For an alternate way to check your spelling using the Shift+Check Spelling option,
which lets you see all misspelled words at once and change only those you want to, see the
section “Inline Spell Checking” below.

To check the spelling of a current composition window, text file, or signature file,
click on the Check Spelling button in the main window toolbar or select Check
Spelling from the Edit menu (Ctrl+6). If there are no misspellings, the “No
misspellings found” alert is displayed.

Note: If text is selected, Eudora checks the spelling only of the selected text. Otherwise, it
starts the spelling check from the beginning of the message body or text file, and checks the
entire text.

If a misspelled, unknown, or repeated word is found, the Check Spelling dialog is
displayed with the word listed in the Unknown field.
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The Check Spelling dialog

To correct the misspelled word, either (1) type the correct spelling of the word in
the Change To field (if it is not already there) and click the Change button, (2)
select the correct word from the Suggestions list and click the Change button, or
(3) double-click the correct word in the Suggestions list. The spelling checker
then proceeds with the check.

Check Spelling Dialog
The Check Spelling dialog allows you to ignore an unknown word, change it,
suggest the correct spelling, add the word to your user dictionary, edit your
dictionary, or change the spelling options via the Options button. Each of the
fields and buttons is described below.

Unknown Field
An unknown word is one that is not found in Eudora’s built-in dictionary or your
own custom dictionary. You can act on an unknown word using the Ignore, Ignore
all, Change, Change all, or Add buttons, as described below.

Change To Field
This field works in conjunction with the Change and Change all buttons. It allows
you to modify the unknown word by typing its correct spelling in this field, or
selecting a suggested alternative spelling from the Suggestions field, and then
clicking the Change or Change all buttons, as described below.

Suggestions Field
This field lists Eudora’s suggestions for the correct spelling of the unknown word.
If the Suggest words option is turned on, all suggestions are listed here by default.
If the option is turned off, click the Suggest button to display Eudora’s
suggestions.
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Ignore Button
This button causes the spelling checker to ignore this occurrence of the unknown
word.

Ignore all Button
This button causes the spelling checker to ignore this occurrence and all
subsequent occurrences of the unknown word.

Change Button
This button substitutes the contents of the Change To field for the unknown word.

Change all Button
This button substitutes the contents of the Change To field for this occurrence and
all subsequent occurrences of the unknown word.

Suggest Button
This button causes the Suggestions field to display a list of Eudora’s suggestions
for the correct spelling of the unknown word.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list any
suggestions.

Add Button
This button adds the unknown word to your custom user dictionary.

Edit Dictionary Button

This button displays the Edit User Dictionary dialog.

The Edit User Dictionary dialog
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The Edit User Dictionary dialog lists all of the words in your user dictionary in
the Dictionary field. It also allows you to add words to or delete words from your
personal user dictionary, or even clear the entire dictionary.

Note: Words in the user dictionary are saved in all lower case.
To add a word to the dictionary using this dialog, type the correct spelling of the
word in the Word field and click the Add button. The word is then added to the
dictionary and displayed in the Dictionary field.

Note: The Add button in this dialog works the same as the Add button in the Check Spelling
dialog.

To remove a word from the user dictionary, first type it in the Word field, or
locate it in the Dictionary field and single-click on it to display it in the Word
field, then click the Delete button.

To delete the entire user dictionary, click the Clear button. You will then be
prompted to confirm the deletions. If you click Yes, all of the words are deleted
from the user dictionary.

Options Button

This button displays the Spelling Options dialog.

Spelling Options dialog

The Spelling Options dialog lists the spell-checking options. A checkmark in the
box next to the option name indicates that the option is turned on.

Note: The spelling options can also be modified in the Options dialog (Spell Checking
category).
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The options are as follows:

Ignore capitalized words
The spelling checker ignores words that start with a capital letter, such as proper
nouns.

Ignore words with all capitals
The spelling checker ignores words that contain all capital letters, such as
acronyms.

Ignore words with numbers
The spelling checker ignores words that contain numbers.

Ignore words with mixed case
The spelling checker ignores words that contain a mixture of uppercase and
lowercase characters.

Report doubled words
The spelling checker reports words that appear twice in sequence in text and
identifies them as Doubled words.

Suggest Words
The spelling checker displays Eudora’s suggestions for the correct spelling of an
unknown word. You can select any combination of the suggestion options:
Phonetic words, Split words, Typographic words.

Note: If Eudora doesn’t have suggestions in its dictionary, then it doesn’t list any
suggestions.

Inline Spell Checking
Inline spell checking is an alternate way to check your spelling: it lets you see all
the misspelled words in your message at once and then change only those you
want to.

To perform inline spell checking on the current composition window, text file, or
signature file, hold down the Shift key and either click on the Check Spelling
button in the main window toolbar or select Check Spelling from the Edit menu.
Or, press Shift+Ctrl+6.

Eudora scans your entire message or the selected text and highlights all the
misspelled words with a red double-underline.

Right-click on a highlighted word and a popup menu displays, letting you choose
from Eudora’s suggestions for the correct spelling of the word. Or, choose Ignore
All to ignore the current and all subsequent occurrences of the word. Or, choose
Add to add the word to Eudora’s dictionary.
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If Eudora has no suggestions in its dictionary for the correct spelling of the
misspelled word, suggestions are not listed in the popup menu.

Go through the message or selection and correct each highlighted word, as
desired, until you are finished the spelling check.

The red double-underline is not a style: it is a visual cue for you only, and is not
sent as a style when Eudora sends the message.

Saving a Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard
when typing long messages, or so you can return to it later to make changes.

To save the current message, select Save from the File menu. Saved messages are
put in the Out mailbox, and if at least one recipient is entered in either the To: or
the Bcc: field, the saved message is shown with a bullet (•) in the Status column.
If both the To: and the Bcc: fields are empty, the Status column is blank. The
bullet indicates that the message not only has been saved but is also ready to be
sent or queued.

A saved (and sendable) message in the Out mailbox

You can continue making changes to the message or close it. If you try to close an
outgoing message window without saving that version of the message, an alert is
displayed asking if the message should be saved or the changes discarded. If you
select Discard and the message has never been saved, the message is deleted.

QUALCOMM Incorporated 43



 



Sending Messages

Sending or Queueing a Message
After you compose a message, you can send it immediately or put it in a queue to
be sent later.

Note: Most SMTP servers do not require a password to send mail. For information about
setting up a password check for sending mail, see the section “Troubleshooting” in the
Eudora Reference Manual.

Sending a Message Immediately
If you want to send your messages immediately instead of putting them in a queue
to send later, then be sure the Immediate send option is on in the Sending Mail
Options.

To send the current message, click on the Send button or select Send
Immediately from the Message menu. A progress window is displayed to show
the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in
the queue, hold down the Shift key and click on the Send button. The Change
Queueing dialog is displayed and you can set detailed instructions. For more
details, see the section “Queueing a Message to Send at a Certain Time.”

Queueing a Message to Send Later
If you want to put your messages in a queue (in the Out mailbox) to send all
together at a later time, be sure the Immediate send option is off in the Sending
Mail Options.

You can set up Eudora to warn you if you try to delete a queued message, or try to
quit Eudora with queued messages. To do this, turn those options on in the Extra
Warnings Options.

To put the current message in the queue, click on the Queue button or select
Queue For Delivery from the Message menu. The message window is closed (if
it was open), the message is saved in the Out mailbox marked Q (meaning it’s
ready to be sent), and the date and time are placed in the Date column.
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Queued messages in the Out mailbox

To send all of your queued messages, select Send Queued Messages from the
File menu. A progress window is displayed momentarily at the top of the screen
indicating the progress of the transmission.

If you have the Immediate send option off, but want to send a message
immediately, hold down the Shift key and click on the Queue button. The
Change Queueing dialog is displayed and you can select the Send Message
Right now option.

Queueing a Message to Send at a Certain Time
You can specify that a message be sent at a certain time in the future. To do this
for the current outgoing message, select Queueing... from the Change submenu
under the Message menu. The Change Queueing dialog is displayed.

The Change Queueing dialog
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If you choose Right now, the message is sent immediately when you click OK. If
you choose Next time queued messages are sent, the message is sent the next
time queued messages are sent.

If you choose On or after, you can use the Time and Date fields to fill in the
time and date at which the message should be sent. The message is saved in the
Out mailbox with a clock icon, , in the Status column, and the specified date
and time in the Date column. The message is sent when the specified time arrives.

Important: For the message to be sent at the correct time, Eudora must be
running at that time. If Eudora is not running, the message is sent the
first time Eudora is run after the specified time has passed.

If you choose Don’t send for a message that has never been queued, nothing
happens. The message is held in the Out mailbox until it is either deleted or re-
queued and sent.

Editing a Queued Message
To edit a queued message, open the Out mailbox and double-click on the message
summary. Make the necessary edits and save them. The message is kept in the
Out mailbox. If you close the changed message without saving it, an alert is
displayed asking you to verify the changes.

Taking a Message Out of the Queue
A message that is queued but is not yet sent can be unqueued using the Change
Queueing command. Open the Out mailbox and select the desired message
summary. Then, select Change Queueing... from the Message menu and click on
Don’t send. This changes the message status from queued (Q) to sendable (•).
The message is held in the Out mailbox until it is either deleted, re-queued, or
sent.

Sending Queued Messages When Checking Mail
If the Send on check option in the Sending Mail Options is on, then every time
Eudora checks for mail (automatically or manually), all queued messages are
automatically sent.
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Sending Messages with Special Server Instructions
To send your queued messages with special instructions for the server (POP
server only), hold down the Shift key and select Send Queued Messages... from
the File menu. The Mail Transfer Options dialog is displayed. Set the options
you want and click OK. All the actions you have requested are completed. For
details, see the section “Managing Your Mail on the POP Server.”

Keeping Copies of Outgoing Messages
There are three ways to keep copies of your outgoing messages:

• To put a copy of every outgoing message in the Out mailbox, turn on the Keep
copies option in the Sending Mail Options.

• To put a copy of the current outgoing message in the Out mailbox, turn on the
Keep Copy button in the message toolbar.

• To put a copy of the current outgoing message in a particular mailbox, right-
click in the body of the message and select the mailbox from the Fcc menu.

In all these cases, when the messages are sent they are put in the specified
mailbox with a checkmark (√) in the Status column, indicating that the message
has been sent.

If none of these options are used, outgoing messages are put into the Trash
mailbox after they have been sent.

Note: You can also set up a filter to save outgoing messages in particular mailboxes based
on information contained in the message. See the section “Filtering Messages” for more
information.
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Checking for Incoming Mail
The incoming mail server is where your mail is received and stored until it is
transferred by Eudora to your PC. You can use several different mail accounts
with Eudora: Your main account, or “dominant personality,” is specified in the
Getting Started Options, and additional mail accounts, or “alternate personalities,”
are set up in the Personalities window and the Account Settings dialog.

Note: To best understand the functioning of the incoming mail server with respect to
Eudora, see the section “Mail Transport” in the Eudora Reference Manual.

There are two ways to check your incoming mail server and transfer mail to your
PC: automatically or manually. These are described in the sections below.

You can also control how your mail is transferred from the server, and what
happens to it on the server. For details, see the sections “Managing Your Mail on
the POP Server” and “Managing Your Mail on the IMAP Server.”

Checking for Mail Automatically
To set up Eudora to automatically check your incoming mail account and transfer
new mail, first open the Checking Mail Options and in the Check for mail
every ? minutes field, enter the number of minutes that you want between mail
checks. Then, open the Personalities window and for each personality that you
want to be automatically checked, right-click on the personality, select Modify...
from the context menu, and when the Account Settings dialog is displayed, turn
on the Check Mail option for that personality.

Note: 15 minutes is a good minimum interval, because checking mail more frequently puts
an unnecessary load on your incoming mail server. If the field is empty, or is set to 0, mail is
not automatically checked.

If automatic checking is set, the Check Mail command under the File menu displays
the next time that an automatic check is scheduled to occur.

The Check Mail option also specifies that an account should be checked for new
mail when a manual mail check is done.

Checking for Mail Manually
You can manually check for new mail at any time by selecting Check Mail from
the File menu. Any account that has the Check Mail option turned on (in the
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Account Settings dialog) is checked. If you haven’t successfully entered your
password since opening the Eudora program, you are prompted for it (for each
account being checked). A progress window is momentarily displayed at the top
of the screen indicating that an attempt to reach your incoming mail account is
being made.

Stopping a Mail Check
If you want to stop a mail check in the middle, click on the Stop button in the
progress window.

Using Your Password
Each time you open Eudora and check mail for the first time, you need to enter a
password for each incoming mail account that you have. This password is
required by the incoming mail server before it will transfer your mail, so that no
one else can get your mail from the server.

Note: This does not protect your mail once it is on your PC. Unless a message has been sent
with some type of security, it is just plain text, which many applications can read. If you are
interested in securing the messages on your PC, you may want to consider a disk driver that
can encrypt hard disk data.

If you need to enter a password, the Eudora Password dialog is displayed. Enter
your password and click OK. If you make a mistake before clicking OK, simply
backspace and re-enter the password correctly.

Note: Your incoming mail account password is case-sensitive, so the uppercase and
lowercase characters must be typed in exactly. Be sure that Caps Lock is off.

The Password dialog
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If your password is rejected, an error message is displayed indicating that you
have entered the wrong password. Select Check Mail from the File menu to
redisplay the password dialog.

As long as Eudora is running, it remembers all of your passwords. If you don’t
want it to remember (if, for example, you are away from your PC), select Forget
Password(s) from the Special menu. The next time you check mail for any
account, you are prompted for your password again.

You can also make Eudora remember all of your passwords from one session to
the next, which means you never have to enter passwords again, even if you quit
and restart Eudora. You only want to do this if your PC is in a secure location,
where there is no possible chance of someone else having access to it. To use this
option, turn on Save password in the Checking Mail Options.

Changing Your Password
To change the password for one of your personalities, select Change Password...
from the Special menu, and select the personality whose password you want to
change. You are prompted to enter your old password once, and your new
password twice. Depending on the server you are using, the password can be up to
30 characters, but normally it is only 7 or 8.

Note: This only works if the incoming mail server is running a compatible password-change
server. For information about these servers, see the “Sources” section of the Eudora
Reference Manual.

When you choose a new password, try not to use real words, names, dates,
familiar acronyms, etc. Some systems require at least one number or symbol in
your password, and you may want to do that even if it is not required.

Receiving New Mail
When Eudora does a mail check, you can be notified of new mail in one or all of
the following ways: an alert dialog, the opening of the mailboxes to which new
mail is delivered, and a special “New Mail” sound. These options are turned on or
off in the Getting Attention Options.

When you receive notice that new mail has arrived, select Eudora from the
Windows task bar. Mail usually arrives in the In mailbox (unless you are using
filters to transfer messages). If the In mailbox is not already open, select In from
the Mailbox menu. The messages are listed in the order they are received, with
the most recent message listed last. Unread messages are designated by a bullet (•)
in the Status column of the message summary.
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Double-click anywhere on a message summary to open the message. You can also
view messages using the message preview pane at the bottom of the mailbox
window while the message summary is highlighted.

Incoming messages are saved indefinitely in the In mailbox (or the mailbox they
are filtered into) until they are deleted or transferred to another mailbox.

The Incoming Message Window
To open an incoming message, double-click on its message summary in a mailbox
window, or, if the message summary is current (highlighted), press the Spacebar
or the Enter key.

An incoming message window

Note: You can also view the message in the message preview pane. See the section
“Working with Mailboxes” for more details.

The incoming message window consists of the title bar, the Toolbar, and the
message body.

Title Bar
The title bar provides information about the message, including the name of the
sender, the time and date the message was delivered, and the message subject.
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Toolbar
The toolbar consists of buttons and popups displayed just under the title bar.

Tow Truck
This can be used to drag any current message into a different mailbox. Just hold
the mouse button down on the icon and drag it to an open mailbox or a mailbox
in the Mailboxes window.

Fixed Width
Click this button to convert the message text to the fixed-width (typewriter-
style) message font set in your Fonts Options. This lets you view aligned text,
such as columns and tables, more easily.

BLAH BLAH BLAH
If this is on, all the message headers (and any formatting codes) are displayed.

Pencil
If this is on, you can edit the message.

Delete From Server
If this is on, the message is deleted from the server the next time mail is
checked.

Retrieve From Server (Fetch)
If this is on, the message is retrieved (fetched) from the server the next time mail
is checked.

Priority Popup
This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Subject
This is the subject that was assigned by the sender, and is shown in the message
summary. For instructions on changing this subject, see the section “Editing
Incoming Messages.”

Message Body
The message body contains the message header and text information, as well as
the name of each attachment and, if the Show attachment icons option is turned
on in the Viewing Mail Options, each attachment’s icon as well. Attachments can
be opened from within the message window by clicking on the attachment icon or
name.
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Eudora lets you view incoming mail with advanced formatting, graphics,
multimedia, and the like. Additionally, if you have the Use Microsoft’s viewer
option turned on in the Viewing Mail Options, and you have Microsoft Internet
Explorer 3.0 or later installed and available on your system, then Eudora lets you
take full advantage of the viewing capabilities of a Web browser right in the e-
mail message itself, or linked to the Internet, without having to open your Web
browser.

Receiving Attachments
Unless you have specified a particular directory for your incoming attachments
(see the section “Specifying an Attachment Directory”), they are automatically
decoded and saved in the Attach Directory in your Eudora Directory. If you
receive multiple attachments with the same name, a number is added to the end of
each duplicate name, in the order they are received.

Attachment names are displayed at the bottom of incoming messages and the
message preview pane. If the Show attachment icons option is turned on in the
Viewing Mail Options, attachment icons are also displayed. To open an
attachment from the open message window or the message preview pane, click on
the attachment name or its icon. If you have the application that the attachment
was created in, that application launches and the attachment opens.

If you receive a large message consisting largely of indecipherable text, it is
probably an attachment that was not automatically decoded. Usually this is
because the attachment headers are formatted incorrectly. To decode an
attachment that was not automatically decoded, open the message and select Save
As... from the File menu to save the message as a text file. Then run the decoding
utility appropriate for the encoding method that the sender used. Decoding
utilities can be found at various shareware sites on the Internet. Also see the
section “Attaching a File to a Message.”

Specifying an Attachment Directory
If you do not want to use the default Attach Directory to receive your attachments,
select Options... from the Tools menu and select the Attachments Options. Then
click on the large button beneath the Attachment directory prompt. A standard
file dialog is displayed.

Double-click on the name of the directory you want to use (its name should be
displayed above the list), then click the Use Directory button. The dialog closes,
leaving the Options dialog displayed. The name of the folder you just selected is
now displayed in the Attachment directory button.
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An Attachments directory is selected

Note: If at any time Eudora cannot find your selected directory, Eudora will use the Attach
Directory in the Eudora Directory for attachments until you designate a new directory.

Editing Incoming Messages
You can edit the message body in an incoming message if you turn on the Pencil
button in the Toolbar. You can also edit the Subject in the Toolbar (this is the
subject shown in the message summary), and you do not need to turn on the
Pencil button to do this.

To edit an incoming message, click on the Pencil button to turn it on, then edit the
message body. (See the section “Formatting Text” for details on how you can edit
the message text.) When you are done, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the
Toolbar (not the subject in the message body). When you are done, click
somewhere else in the message, or close it. The new subject is displayed in the
message summary. The contents of the Subject field of the message header
remain unchanged.
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Note: If you reply to the message, the original subject is used for the reply, not your
changed subject.

Using Active URLs
Any string of text that Eudora recognizes as a hot link or URL (Uniform Resource
Locator: http, ftp, gopher, ph, finger, etc.) is active. Click on a URL to open a
World Wide Web location, transfer a file, do a gopher search, use the finger tool,
etc. URLs are highlighted and underlined to show that they are active.

To set up Eudora to automatically open a new message when you use a “mailto:”
link within a Netscape Web browser, turn on the Intercept Netscape mailto
URLs option in the Miscellaneous Options.

Managing Your Mail on the POP Server
During a mail check, your incoming messages are normally transferred from your
account on the POP server to your PC, and then deleted from the POP server. But
this can be awkward if you want to read mail from two or more computers, and
keep your mail organized at the same time.

There are several options that you can use to control your mail transfers and the
storage on the server. Some of these options are available in the Incoming Mail
Options, for your dominant account only, and the Account Settings dialog, for any
of your personalities; some of the options are available in the Mail Transfer
Options dialog.

Leaving Mail on the Server
To transfer all of your new messages from the POP server to the PC you are on,
and also leave copies of those messages on the server, turn on the Leave mail on
server option in the Incoming Mail Options. You can use the Delete from server
after ? days option to set the maximum number of days the copies should be
kept.

Note: The Leave mail on server option can also be set for each alternate personality you
have. To do this, use the Account Settings dialog, accessed from the Personalities window.

At the next mail check from that PC, Eudora ignores the copies of those
previously read messages and looks for new ones. However, if you check mail
from another computer, those messages are treated as new and are transferred to
that computer.

Note: The Leave mail on server option should be used with care, since it can result in a
buildup of messages on the POP server.
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Deleting a Message from the Server
To delete a message that has been left on the server (without retrieving it again),
turn on the Trash button in the message Toolbar or set the message summary’s
server status to Delete, then check mail again. Or, use the Delete all messages
that have been retrieved option in the Mail Transfer Options dialog (described
in the section “Checking for Mail with Special Server Instructions”).

Skipping Messages Over a Certain Size
To stop Eudora from transferring incoming messages that are too large, turn on
the Skip messages over ? K in size option in the Incoming Mail Options, and
specify a size. Only the first few lines of the messages that exceed that size are
transferred, with a note at the bottom stating that the whole message has not been
transferred.

Note: The Skip messages over ? K in size option can also be set for each alternate
personality you have. To do this, use the Account Settings dialog, accessed from the
Personalities window.

If you decide you want to transfer the whole message, click on the Fetch button in
the incoming message window, or select the Fetch server status in the message
summary, then check mail again. You can also use the Trash button or the Fetch
then Delete server status so that the message is deleted from the server after it is
transferred.

If you decide you don’t want the message and want to delete it from the server,
click on the Trash button in the incoming message window, or select the Delete
server status in the message summary, then check mail again.

Checking for Mail with Special Server Instructions
To check your mail and give special transfer and storage instructions to the POP
server, hold down the Shift key and select Check Mail from the File menu. The
Mail Transfer Options dialog is displayed. Set the options you want and click on
the OK button to continue checking for mail.
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The Mail Transfer Options dialog

The mail transfer options are described below.

Retrieve new mail
Transfer your new mail from the POP server to your PC.

Send queued messages
Send all the queued messages (marked “Q”) in your Out mailbox.

Delete messages marked for deletion
Delete from the POP server the messages that are marked Delete in Eudora. This
is for messages that were retrieved only in part, either with the Leave mail on
server or Skip messages over ? K in size options (in the Incoming Mail Options
for your main account or the Account Settings dialog for your alternate
personalities), or with the Fetch all message headers to In mailbox option (in
the Mail Transfer Options dialog).

Retrieve messages marked for retrieval
Retrieve from the POP server the messages that are marked Fetch or Fetch then
Delete in Eudora. This is for messages that were retrieved only in part, either with
the Leave mail on server or Skip messages over ? K in size options (in the
Incoming Mail Options for your main account or the Account Settings dialog for
your alternate personalities), or with the Fetch all message headers to In
mailbox option (in the Mail Transfer Options dialog).

58 QUALCOMM Incorporated



Eudora User Manual Receiving Messages

Note: To mark a message Fetch, Delete, or Fetch then Delete, either click on the buttons in
the incoming message window, or select an option from the Server Status popup of the
message summary.

Delete all messages that have been retrieved
Delete from the POP server all of the messages that have already been transferred
to the PC you are on.

Delete all messages on server
Delete all of your messages from the POP server. Note: Be absolutely sure this is
what you want to do, because there is no way to undo it!

Fetch all message headers to In mailbox
Retrieve from the POP server the header and the first few lines of every new
message. If you select this option, the messages are not filtered. Set the Server
Status in the message summaries to specify what you want to do with the
messages the next time you check mail.

Important: If you delete the message header, and you have the Delete from
server when emptied from Trash option on in either the Incoming
Mail Options for your main account, or the Account Settings dialog
for an alternate account, the message is gone completely from
Eudora and the POP server.

How should checking/sending be performed
If you have multiple personalities, you can check or send mail based on the
options on the left of the Mail Transfer Options dialog (turn on Using options at
left), or as specified in the Incoming Mail Options, for your dominant account
only, or in the Account Settings dialog (accessed from the Personalities window),
for any of your personalities (turn on Normally). You can also specify the
personalities that you want to check or send with this mail transfer. Hold down the
Shift key to select multiple personalities in sequence, or the Ctrl key to select
them out of sequence.

Note: Another way to check mail for multiple personalities, regardless of your settings
elsewhere, is to open the Personalities window, select your desired personalities, right-click
on the selection, and select Check Mail from the popup menu.

Managing Your Mail on the IMAP Server
If your incoming mail server uses IMAP, then when you check mail, all incoming
messages are delivered to your IMAP server and are kept there until you actively
delete them.

Also during mail checks, partial messages or full messages are transferred to your
PC, with or without attachments, depending on the options you specify in the
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Incoming Mail Options for your main account, or the Account Settings dialog,
accessed from the Personalities window, for any of your personalities. These
options are described further below.

When a message is transferred, either in part or in full, from the IMAP server to
your PC during a mail check, a copy of the message remains on the server until
you actively delete it. Also, your PC remains connected to the IMAP server until
you close the mailbox containing the message (assuming the mailbox opens when
the message is delivered).

Downloading Minimal Headers vs. the Full Message
By default, the Minimal Headers Only option is turned on in the Incoming Mail
Options for your dominant account, and in the Account Settings dialog for your
alternate personalities.

As a result, when you check mail for an account and the incoming mail is
delivered to your IMAP server, only a minimal amount of information about each
message is transferred to your PC. This consists of the information you would see
in the message summary of a mailbox window: the sender, the date and time of
the message, the subject, etc. When you open or preview the message, however,
the full set of message headers and the entire message body is transferred to your
PC. Whether or not any attachments to the message are also transferred depends
on your setting for the Skip Attachments over ? K option.

If you always want the full message to be transferred to your PC during mail
checks (with or without attachments, as specified separately), rather than just the
minimal headers, then turn off the Minimal Headers Only option.

Skipping Attachments Over a Certain Size
To prevent Eudora from transferring large attachments to your PC during mail
checks, turn on the Skip Attachments over ? K option, and specify a size. You
can set this option in the Incoming Mail Options for your main account, or in the
Account Settings dialog for any of your personalities.

Each time mail is then checked for the account, any attachments larger than the
specified size are not transferred to your PC with the message. The rest of the
message, however, is transferred: either minimal headers only, or the full set of
message headers and the complete message body, depending on your setting for
the Minimal Headers Only option. Any attachments within the specified size are
also transferred.

Attachments not transferred during mail checks can still be downloaded: when
you open or preview the message associated with the attachment, an icon for the

60 QUALCOMM Incorporated



Eudora User Manual Receiving Messages

attachment is displayed in the incoming message window or the message preview
pane. (The Show attachment icons option must be turned on in the Viewing Mail
Options in order for this icon to appear.) Click on the icon to retrieve the
attachment from the IMAP server.

If the Skip Attachments over ? K option is turned off, then all attachments are
transferred to your PC during mail checks, regardless of their size.

Deleting a Message from the Server
To delete a message from the IMAP server, you must take two steps: first mark
the message for deletion, then remove all messages so marked.

To mark a message for deletion, open the IMAP mailbox or folder containing the
message, then select or open the message and select Delete from the Message
menu. (To unmark a marked message so that it won’t be deleted from the IMAP
server, select or open the message and then select UnDelete from the Message
menu.)

To remove from the IMAP server all messages marked for deletion, select
Remove Deleted Messages from the Message menu. The messages are
completely removed both from the IMAP server and from your PC.

Once you remove marked messages using the Remove Deleted Messages
command, these messages are completely gone and cannot be restored. Therefore,
use this command with caution.

Resynchronizing an IMAP Mailbox or Folder
General mailbox and folder management for POP and IMAP servers is performed
from the Mailboxes window. See “Using the Mailboxes Window” for more
information. This section discusses resynchronization.

Keeping your mailboxes and folders remotely, on an IMAP server, lets you
perform operations on them from different computers. For a particular IMAP
mailbox, you may delete some messages from the mailbox from one PC, check
mail from another PC (resulting in new messages being transferred to the
mailbox), and change the status of some of the messages from a third PC.

Each PC has no idea what has been done to the mailbox from the other PC until
you resynchronize the mailbox, which updates all operations performed on the
mailbox from all computers that have access to the mailbox. (In some situations,
other users may have access to these same mailboxes.)

To resynchronize an IMAP mailbox or folder, open the Mailboxes window, right-
click on the mailbox or folder, and select Resynchronize Mailbox from the
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popup menu. The content of the mailbox or folder is completely updated
according to all operations that have been performed on the mailbox from all
computers that have access to it.

Refreshing Your List of IMAP Mailboxes and Folders
General mailbox and folder management for POP and IMAP servers is performed
from the Mailboxes window. See “Using the Mailboxes Window” for more
information. This section discusses how to update the list of IMAP mailboxes and
folders in the Mailboxes window.

Mailboxes and folders you keep stored remotely, on an IMAP server, may be
changed by other users, or may be changed by you from other computers. The
Mailboxes window does not reflect the “real-time” status of the IMAP mailbox
list, and between mail checks, a disparity can grow between what appears in the
list and what is actually on the IMAP server, as new mailboxes are added and
existing ones are changed or removed.

To refresh your list of mailboxes and folders on the IMAP server, as it appears in
the Mailboxes window, open the Mailboxes window, right-click on the top folder
in the IMAP tree, and select Refresh Mailbox List from the popup menu. The
mailbox list is updated according to what actually appears on the IMAP server at
that time. The Mailbox and Transfer menus are also updated with the current
IMAP mailbox configuration.
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Replying to a Message
To reply to the current message, select Reply from the Message menu. A new
message window is displayed, with the original sender’s address automatically
placed in the To field of the header. All of the sender’s original text is quoted in
the message body. This text can be edited as needed. Additional text can be added
to the reply just as to any outgoing message, and the reply can then be sent or
saved for further changes.

If the sender’s text did not include style information, each line is prefixed by a
greater-than symbol (>).

Quoted text that does not include style information

If the sender’s text did include style information (e.g., bold text), it is quoted with
a left sidebar, also called an “excerpt bar.”

Quoted text that includes style information

Messages that have been replied to are identified with a left arrow, , in the
Status column of their message summary.

Using the Reply Options
There are several options that you can use when replying to messages.

To include everyone who received the original message, select Reply to All from
the Message menu.

To include yourself as a recipient, turn on the Include yourself option in the
Replying Options. This only works if you are using Reply to All.
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Note: To determine who you are for the Include yourself option, Eudora uses the “me”
nickname. If you do not have a “me” nickname set up in your Address Book, Eudora uses the
contents of the Mail Server (Incoming), Login Name, and Return address fields from the
Getting Started Options. (Incoming mail accounts are usually of the form
loginname@mailservername.) The “me” nickname is particularly useful if you have
multiple addresses and don’t want replies to go to any of those addresses.

To put the addresses of the other recipients of the original message in the Cc field
(instead of the To field), turn on the Put original To: recipients in Cc: field
option in the Replying Options. Only the original sender’s address is put in the To
field. This only works if you are using Reply to All.

 "Replying Options:Copy original’s priority to reply option\;.i.Reply:Copy
original’s priority to reply option" To copy the original message’s priority to your
replies, turn on the Copy original’s priority to reply option in the Replying
Options.

To change the keyboard shortcut Ctrl+R from its normal function of Reply to
Reply to All, turn on the Map Ctrl+R to “Reply to All” option in the Replying
Options. The change is reflected on the Message menu.

Replying with a Stationery File
To reply to a message with a stationery file, select a stationery file from the Reply
With submenu under the Message menu. The stationery file is opened as a
message and is addressed as appropriate (your Replying Options are used). For
details about stationery, see the section “Using a Stationery File.”

Other ways to reply with stationery:

• With the desired message open or selected in a mailbox window: Open the
Stationery window, right-click on a stationery item, and select Reply With
from the popup menu.

• With the desired message open or selected in a mailbox window: Open the
Personalities window, right-click on a personality, and select Reply As from
the Message submenu of the popup menu. The default stationery assigned to
that personality is used in the reply.

• With the Personalities window open: Drag an open message by its Tow Truck,
or drag selected message summaries in a mailbox window, onto a personality
in the Personalities window: a reply is initiated from that personality, and the
stationery stored with that personality is used in the reply.

• Set up a filter that uses the Reply with filter action. See the sections “Filtering
Messages” and “Filter Actions.”
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Forwarding a Message
Any message can be forwarded to someone else. To forward the current message,
select Forward from the Message menu. A new message window is displayed
with your address in the From field, the original subject preceded by “Fwd:” and
a space in the Subject field, the original sender’s text quoted in the message body,
and the original attachments in the Attached field. For details on how text is
quoted, see the section “Replying to a Message.” Make any changes you want,
and enter the recipient’s address in the To field. The message can then be sent or
saved for further changes.

Note: If you forward an outgoing message (a message you sent), the attachments are not
automatically included.

Messages that have been forwarded are identified with a right arrow, , in the
Status column of their message summary.

Other ways to forward a message:

• With the desired message open or selected in a mailbox window: Open the
Personalities window, right-click on a personality, and select Forward As from
the Message submenu of the popup menu.

• Set up a filter that uses the Forward To filter action. See the sections
“Filtering Messages” and “Filter Actions.”

Redirecting a Message
Incoming messages can be sent to a new recipient “by way of” you, maintaining
the original sender’s address in the From field. This is called redirecting.

To redirect the current message, select Redirect from the Message menu. A new
message window is displayed with the original sender’s address in the From field
with the statement “by way of” followed by your real name and/or return address,
the original sender’s text in the message body, and the original attachments in the
Attached field. Make any changes you want, and enter the recipient’s address in
the To field. The message can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([]) so that you don’t confuse the
recipient about who wrote what.
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A redirected message

Messages that have been redirected are identified with a diagonal arrow pointing
up and right, , in the Status column of their message summary.

Other ways to redirect a message:

• With the desired message open or selected in a mailbox window: Open the
Personalities window, right-click on a personality, and select Redirect As from
the Message submenu of the popup menu.

• Set up a filter that uses the Redirect To filter action. See the sections “Filtering
Messages” and “Filter Actions.”

Turbo Redirecting
You can redirect a message to someone on your recipient list, queue the new
message (without displaying it), and delete the original message, all with one
command. To do this, turn on the Turbo redirect by default option in the
Miscellaneous Options, and when you select a recipient from the Redirect To
submenu under the Message menu, a turbo redirect is automatically performed.

Redirect and Signatures
When you use Redirect or Redirect To, your signature is not added to the
message when it is sent, unless you originally created the message. Eudora
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considers the message to be originally from you if the address in the From field
exactly matches either your return address or one of the addresses belonging to
your nickname called “me,” if you have one.

Sending Rejected Messages Again
If for some reason an e-mail message can’t be delivered to a recipient, mail
transport agents return the message to the original sender (you). A message is
typically rejected because of an error in the recipient’s address, although many
other reasons are possible.

The return message usually includes cryptic information that may let you
determine the reason the message was rejected. It also includes the text of the
original message.

You can easily recover the original message, make any corrections, and resend it.
To do this for the current message, select Send Again from the Message menu.
This eliminates the inserted extra text and reformats the message as it originally
appeared. You can then make changes or additions and send the message again.

The Send Again command is also useful for resending saved messages—from
your Out box, for example—and messages you’ve copied to yourself, in order to
save yourself some retyping. You can send the same message to another recipient
to avoid having to retype the whole message, or you can send a different message
to the same recipients to avoid having to retype their addresses in the header.

Another way to send again: With the desired message open or selected in a
mailbox window, open the Personalities window, right-click on a personality, and
select Send Again As from the Message submenu of the popup menu. The
message is sent again but from the selected personality (which may or may not be
the same as the personality under which it was originally sent).
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Opening a Mailbox
To open a mailbox, select it from the Mailbox menu, or double-click on it in the
Mailboxes window.

Note: The unread message icon is displayed in the Mailbox menu whenever a mailbox or
folder contains unread messages that are less than five days old, and any mailboxes or folders
in the Mailboxes window that contain unread messages are displayed as bold.

The Anatomy of a Mailbox
Mailbox windows contain all of your incoming and outgoing message summaries.
If the Show message preview pane option is turned on in the Viewing Mail
Options, mailbox windows also show the message preview pane.

To open a mailbox, select it from the Mailbox menu, or double-click on it in the
Mailboxes window.

A mailbox window
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Message Summaries
Each line in the list portion of a mailbox window represents a message and is
called a message summary. Outgoing messages that are in any mailbox other than
Out are shown with italicized message summaries.

To select one or more message summaries, use one of the following options:

• To select one summary, click on it.

• To select two summaries and all the summaries between them, select a
summary, hold down the Shift key, and select another summary. Or, drag the
mouse over the summaries to select them (as long as you begin on an
unselected summary).

• To select all of the summaries that have the same information in a particular
column, hold down the Alt key and click on one column in the summary. For
example, if you click on the Status column for one summary, all of the
summaries with that status are selected.

• To make “disjointed” selections, hold down the Ctrl key and select summaries.

Each message summary is divided into columns. The column names are shown
below with the corresponding icons that appear in the column headings.

Status

Priority

Attachments

Label

Sender/Recipient (Who)

Date

Size (in kilobytes, K)

Server Status

Subject

You can show or hide these columns using the Display Options.
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A message’s Status, Priority, Label, and Server Status can be changed directly in
the mailbox window. To do this, select the messages you want to change and click
the right mouse button inside the selection. Select an option from the popup menu
to make your change.

To turn on the display of lines in the message summaries portion of mailbox
windows—horizontal lines to separate summaries, and vertical lines to separate
columns—turn on the Show mailbox lines option in the Display Options.

The Status Column
This column displays the message status, which is one of the following:

The message has not been read (all mailboxes except Out), or is
queueable or sendable but has not been queued or sent (Out mailbox
only).

<blank> The message has been read (all mailboxes except Out), or is not yet
able to be queued or sent because it has no recipients in the To or Bcc
fields (Out mailbox only).

Reply has been chosen for the message.

Forward has been chosen for the message.

Redirect has been chosen for the message.

The message has been sent (outgoing messages only).

The message is queued to be sent (outgoing messages only).

The message is queued to be sent at a specified time (outgoing
messages only).

The message was transferred from the Out mailbox before being sent.

You can change the status of one or more selected messages, or an open message,
from Read (blank) to Unread (•) or from Unread to Read by pressing Shift+Space
(all mailboxes except Out).

The Priority Column
This column displays the message priority. You can use the popup to set a
particular priority.

Highest priority.

High priority.
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<blank> Normal priority.

Low priority.

Lowest priority.

For more information on message priorities, see the section “Setting the Message
Priority.”

The Attachments Column
If a message has attached documents, this column displays the attachment icon, a

paper clip ( ).

Note: This attachment icon is not affected by the Show attachment icons option in the
Viewing Mail Options. This attachment icon appears whether Show attachment icons is
turned on or off. The Show attachment icons option refers to attachment icons in the open
incoming message and the message preview pane.

The Label Column
This column displays the message label. Labels are assigned to incoming
messages by the recipient, either manually or automatically using filters (see the
section “Filtering Messages”). When a message summary is assigned a label, the
entire summary changes color to match the label color.

Note: Label colors and titles are assigned using the Labels Options.
The Sender/Recipient Column (Who)
This column shows the sender of the message (for incoming messages) or the
intended recipients (for outgoing messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to display the sender
of incoming messages as ???@???. This is because the required From: header is missing.

The Date Column
This column displays the date and time the message was composed, or, for timed
messages, the date and time the message is scheduled to be sent. Date formats,
including age-sensitive indications such as the day of the week or “Today,” are set
in the Date Display Options. See the Eudora Reference Manual for more
information.

The Size Column
This column displays the size of the message in kilobytes, K (1 K = 1,024 bytes).
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The Server Status Column
This column displays the action that is done to the corresponding incoming
message on the POP server (these actions do not apply on an IMAP server). The
next time you check mail, the server status you requested is automatically
completed.

Leave Don’t change the message on the POP server. A solid
diamond indicates that the message has been fetched; an
open diamond indicates that the message has not yet been
fetched.

Fetch Download the whole message from the POP server.

Delete Delete the message from the POP server.

Fetch then
Delete

Download the whole message then delete it from the POP
server.

Note: To control the mail transfer, you can also use the Mail Transfer Options dialog. For
details, see the section “Checking for Mail with Special Server Instructions.”

The Subject Column
This column displays the subject of the message. The sender originally typed this
information into the message header, but you can modify it (see the section
“Editing Incoming Messages”).

Displaying and Resizing Columns
To specify which columns you want to be displayed in your mailboxes, select
Options... from the Tools menu, click on Display and be sure the columns you
want to see are on in the Show Mailbox Columns block.

To resize a column in a mailbox window, move the mouse pointer until it is over
the column heading divider to the right of the column you want to resize, then
drag the divider to the position you want. The column divider moves to the new
location, and the mailbox is redrawn.

You can only shrink a column as far as its left divider. If you do that, a double
divider line is displayed in place of the column, and its contents are hidden. To
redisplay the column, drag the right divider line to the right.

Using the Mailbox Size Display
In the lower left corner of the message summary part of each mailbox window,
three numbers show the size information for that mailbox. The first is the number
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of messages in the mailbox; the second is the total amount of space those
messages require; the third is the amount of disk space that is wasted with the
mailbox.

The mailbox size display

Wasted space is created when messages are deleted or transferred from a mailbox.
This wasted space is automatically removed when the amount of wasted space in
the mailbox is greater than the amount of space the messages in the mailbox use,
or if the amount of space wasted in the mailbox is greater than 5% of the free
space on the disk drive that contains it.

To manually clean up the wasted space in a mailbox, click on the mailbox’s size
display. Or, to clean up all your mailboxes, select Compact Mailboxes from the
Special menu.

The Message Preview Pane
If the Show message preview pane option is turned on in the Viewing Mail
Options, then the message preview pane appears in roughly the bottom half of the
mailbox window.

The message preview pane shows the key headers and the message body of the
currently selected message in the message summary list. If the full message body
is not visible in the preview pane, scroll bars are displayed, allowing you to view
the rest of the message. Only one message can be previewed at a time.

Press Tab or F6 to move the keyboard focus from the message summary list to
the message preview pane (and back again). Or simply click in the preview pane
to put the focus there.

Once keyboard focus is in the preview pane, you can do any of the following, as
you can in an open incoming message window:

• Press Space to page down through the message.

• Use the arrow keys, as set in the Miscellaneous Options (unmodified or with
Ctrl or Alt), to switch to the next or previous message in the mailbox.

• Use standard keyboard shortcuts such as Ctrl+R for Reply, Ctrl+D for Delete,
etc.
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• Right-click anywhere in the preview pane to display a popup menu with
commands appropriate for the previewed message.

• Click on an attachment icon or name to open the attachment.

• Click on a URL (hot link) to launch the application for that URL.

If the Show message preview pane option is turned on in the Viewing Mail
Options, you can press F7 to show and hide the preview pane within the current
mailbox only (this does not control the visibility of the preview pane in other
mailboxes).

You can change the height of the preview pane relative to the message summary
list by positioning the mouse pointer over the separator bar between the list and
the preview pane, and dragging the bar up or down.

If the Show message preview pane option is off in the Viewing Mail Options,
only the message summaries are shown in any mailbox window.

If the preview pane option is on and the Mark previewed messages as read after
? second(s) option is turned on in the Viewing Mail Options, then the currently
previewed message is marked as read (blank in the Status column) after the
specified number of seconds (subject to the Note below). You can always change
the message’s status back to Unread (•) by pressing Shift+Space while the
message is selected or open (press again to change back to Read). If the Mark
previewed... option is off, previewed messages are never automatically marked as
read.

Note: Eudora only performs the auto-marking behavior when you manually switch
messages, not when it performs actions such as automatic mail checks or filtering.

Creating Mailboxes and Folders
Eudora lets you create mailboxes to put messages in, and folders to put mailboxes
(or more folders) in.

There are three ways to create mailboxes and folders:

• Using the New... command from the Mailbox menu and folder submenus.

• Using the New... command from the popup menu in the Mailboxes window
(see the section “Using the Mailboxes Window”).

• Using the New... command from the Transfer menu (see the section
“Transferring Messages”).
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Note that depending on whether your incoming mail server uses the POP or IMAP
protocol, there are some differences in the way mailboxes and mail folders are
created, stored, and managed. For more information, see the section “Mailbox and
Folder Management: POP vs. IMAP Server.”

Creating a Mailbox or Folder Using the Mailbox Menu
To create a new mailbox or mail folder, select New... from the Mailbox menu, or
from a mail folder submenu (to put the mailbox in that folder). The New Mailbox
dialog is displayed.

New Mailbox dialog

To create a mailbox, type in the new mailbox name and click OK. The mailbox is
created and added to the Mailbox and Transfer menus and to the Mailboxes
window.

To create a mail folder, type the name of the new mail folder and check the Make
it a folder option. Click OK to create the folder. The New Mailbox dialog is
displayed again. Type the name of a mailbox to create within the new folder, then
click OK. The new folder and its mailbox are displayed in the Mailbox and
Transfer menus and in the Mailboxes window.

Using the Mailboxes Window
The Mailboxes window lets you create new mailboxes and folders, remove and
rename them, and move mailboxes among folders. Mailboxes or folders that are
bolded have unread messages.
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By default, the Mailboxes window is provided as the first window in a five-
window tool group docked vertically to the left side of the main Eudora window.

To open the Mailboxes window, select Mailboxes from the Tools menu, or click
on the Mailboxes window’s tab if it is part of a visible tabbed window group. For
more information on how to manipulate the Mailboxes window alone and as part
of a tabbed window group, see the section “Managing Your Windows in Eudora.”

The Mailboxes window

To open a mailbox or folder within the window, double-click on it, or click on it
once and press Enter. You can move among the folders and mailboxes using the
up and down arrow keys, or close or open folders using the left and right arrow
keys. You can also start typing the name of the mailbox or folder you want, and it
is highlighted when you have typed enough unique characters to identify it (the
item must be displayed, so a mailbox that is in a closed folder cannot be selected).

Right-click on any item in the Mailboxes window and a popup menu is displayed
whose commands let you, depending on the item, create, remove, and rename
mailboxes and folders, open existing mailboxes and folders, and empty the trash
from the Trash mailbox.

The folder trees displayed in the Mailboxes window, and some of the operations
available from the popup menu, depend on whether your incoming mail server for
one or more mail accounts uses the POP or the IMAP protocol. For more
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information on these differences, see the section “Mailbox and Folder
Management: POP vs. IMAP Server.”

Creating a New Mailbox or Folder
To create a new mailbox or folder in the Mailboxes window, right-click on a
folder and select New... from the popup menu. A dialog is displayed requesting
the name of the new mailbox or folder.

Type in the new name, check the Make it a folder option if you want to, and
click OK. If you chose to make it a folder, enter the name of the mailbox within
the new folder when the dialog appears again, and click OK. The new mailbox or
folder is displayed in the lists, and is added to the Mailbox and Transfer menus.

Renaming a Mailbox or Folder
To rename a mailbox or folder, click on it once, pause, then click again to
highlight just the name. Then type in the new name. Or, right-click on the item
and select Rename, or click once on the item and press F2, then type in the new
name. Press Enter to accept your change, or Esc to cancel it.

Moving a Mailbox from One Folder to Another
To move a mailbox from one folder to another, select the one you want to move
and drag it to where you want it.

Removing a Mailbox or Folder
To remove a mailbox or folder, either right-click on it and select Delete from the
popup menu, or click once on it to highlight it and then press the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder
in which other mailboxes or folders are stored, you are prompted to confirm the
deletion for each such item selected. Click Remove it to delete the current item
for which you are being prompted, or click Remove all to remove all items
selected for deletion—no further prompts will appear. Or click Cancel to cancel
the deletion. If you delete a non-empty mailbox or folder, all messages,
mailboxes, and folders contained within the mailbox or folder are also deleted.

Mailbox and Folder Management: POP vs. IMAP Server
The location of your mailboxes and mail folders depends on whether your
incoming mail server for your account uses the POP or IMAP protocol.

If your incoming mail server uses POP, then all of your mailboxes and mail
folders are created and stored on your PC. If your incoming mail server uses
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IMAP, then all of your mailboxes and mail folders are created and stored on the
IMAP server.

The parallel situation holds true if you have multiple e-mail accounts: mailboxes
and folders for all of your POP accounts are stored on your PC; mailboxes and
folders for all of your IMAP accounts are stored on the respective IMAP servers.

You create an IMAP server account using the New Account Setup wizard for your
dominant personality (see “Getting Started”), or using the Account Settings
dialog, accessed from the Personalities window, for an alternate personality (see
“Personalities Window”).

The Mailboxes window is the main tool for managing your IMAP mailboxes and
mail folders. In the Mailboxes window, right-click on one of the folders or
mailboxes in an IMAP hierarchy and select an item from the popup menu. See
“Using the Mailboxes Window” for more information. (The additional commands
for IMAP are Refresh Mailbox List and Resynchronize Mailbox.)

Mail folders stored on an IMAP server can contain not only mailboxes but also
messages. Mail folders stored on a POP server can only contain mailboxes, not
messages.

Some mailboxes stored on your IMAP server may have been created by others
and made accessible to you. For some of these mailboxes you may have both
“read and write” permission: that is, you can not only read the messages stored in
them but also change or delete the messages. Other mailboxes may give you only
“read” permission: you can only read the messages, not change or delete them.

If you have multiple e-mail accounts and the incoming mail servers for all of them
use POP, then you will have only one top-level mail folder, named Eudora by
default. If the incoming mail server for at least one of your personalities uses
IMAP, then you can have multiple top-level mail folders: one to hold mail from
all of your POP accounts, and one top-level folder for each of your IMAP
accounts. The name of a top-level IMAP folder is the personality name for that
IMAP account.

For more information on managing your mail on POP and IMAP servers, see the
sections “Managing Your Mail on the POP Server” and “Managing Your Mail on
the IMAP Server.”
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Deleting a Message
As a safeguard against inadvertent deletions, two steps are used to delete a
message from your PC: first you put the message in the Trash, then you empty the
Trash. (If your incoming mail server uses IMAP, the procedure is slightly
different, as described below.)

To put a message in the Trash, select the message, then select Delete from the
Message menu, or select Trash from the Transfer menu, or press the Delete key,
or click the Delete toolbar button. The message is transferred to the Trash
mailbox.

To delete the messages in the Trash mailbox (removing them permanently from
your PC), select Empty Trash from the Special menu. Or, if the Mailboxes
window is open on your desktop, right-click on the Trash mailbox in the window
and select Empty Trash from the popup menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent
messages. To do this, use the Extra Warnings Options to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty
Trash when exiting option in the Miscellaneous Options is turned on.

Finally, if you want to delete just a few messages from the Trash mailbox, open
the Trash mailbox, select the desired messages, then select Delete from the
Message menu, or press the Delete key. Deleting a message from the Trash
removes it completely.

If your incoming mail server uses IMAP, the two steps required to remove a
message from your PC are to first mark it for deletion, then remove marked
messages.

To mark for deletion a message stored in an IMAP mailbox or folder, select the
message and then select Delete from the Message menu. To unmark the message
for deletion, select it and then select UnDelete from the Message menu. To
remove all messages marked for deletion, select Remove Deleted Messages from
the Message menu. The messages are completely removed not only from your PC
but also from the IMAP server.
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Automatically Deleting Attachments
When you delete messages, you can have their attachments automatically deleted.
To do this, turn on the Delete attachments when emptying Trash option in the
Attachments Options, and be sure the attachments are still in the Attach
Directory (or the directory you have specified for attachments). If you have this
option on, and want to delete a message but save its attachment, move the
attachment into another directory before deleting the message.

Transferring Messages
You can transfer messages to any of your mailboxes. There are several ways to do
this:

• Select the message(s) you want to transfer, then select a mailbox from the
Transfer menu.

• Select the message(s) you want to transfer, then right-click on the selection and
choose a mailbox from the transfer submenu.

• Drag a message summary to an open mailbox window or to a mailbox icon in
the Mailboxes window.

To put a copy of a message in another mailbox (instead of transferring the
message), hold down the Shift key and use one of the transfer options above. This
is useful if you want to file a message in more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert is displayed informing
you that some header information may be removed from the message during
transfer. Click Yes to transfer the message.

Using the Transfer Menu
The Transfer menu is one way to transfer messages among your mailboxes. With
a current message open, or message summaries selected, select a mailbox from the
Transfer menu. The messages are transferred from their previous mailbox to the
mailbox you selected.

Dragging Messages
You can drag messages from one mailbox to another using the message
summaries or the Tow Truck icon in an open message window.

To drag a message summary to another mailbox, select the message summary (or
summaries) and drag the summary into any open or minimized mailbox window,
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or any mailbox in the Mailboxes window. When you release the mouse button, the
message is transferred.

To drag an open message to another mailbox, hold down the mouse over the Tow
Truck icon and drag the message into any open mailbox or any mailbox in the
Mailboxes window. When you release the mouse button, the message is
transferred.

When dragging to the Mailboxes window, pause over a closed folder and the
folder temporarily opens, making its mailboxes visible so that you can complete
the drop operation. The folder closes again when you complete or cancel the drop.

Creating a Mailbox or Folder During Transfer
To create a mailbox and transfer the current message into it at the same time,
select New... from the Transfer menu instead of the name of a mailbox. The New
Mailbox dialog is displayed.

You can create a new mailbox or mail folder (for details, see the section “Creating
Mailboxes and Folders”). When you are done, the current message is transferred
into the new mailbox.

To create the new mailbox without transferring the message into it, check the
Don’t transfer, just create mailbox option.

Filtering Messages
Many of the e-mail management functions in Eudora can be done automatically
using filters. For example, you can automatically reply to a request for
information, transfer all the messages from your children into a Personal mailbox,
and label all the messages from your customers as “Hot.”

A filter can be thought of as a personal “valet” or “butler” that takes your mail and
does certain things to it that you specify. One kind of valet might watch for
particular mail from a mailing list and move it into a mailbox, open the message,
and play a sound. Another might look for other kinds of mail and give it a label
color, a high priority, and a new Subject line. You can create as many of these
“valets” or “butlers” as you like and give each of them from one to five
instructions on what to do with your mail that fits a certain set of criteria, based on
information in the header of the message and the message body.

Quick and Simple Filters with the Make Filter Dialog
The simplest filters are those that transfer incoming messages to a particular
mailbox based on the sender of the message or one or more of the recipients. For
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example, each time you check your mail, you may want to have Eudora take all of
the incoming messages it receives from your friend Joe and automatically transfer
them into a mailbox you’ve called “Mail from Joe.” To get Eudora to do this, you
set up a simple filter.

For new users, the Make Filter dialog provides an easy way to learn how to use
filters. Once you get comfortable with the simple filters created this way, you can
go on to make more complex, powerful filters using the Filters window.
Experienced users will find that the Make Filter dialog provides a rapid,
convenient method for making a simple transfer filter.

To open the Make Filter dialog, open an incoming or outgoing message
containing the information you want in your filter, or select one or more message
summaries in a mailbox, and select Make Filter from the Special menu. Or,
right-click in the body of the open message, or in the selection of message
summaries, or in the preview pane for a single-selected message, and select Make
Filter from the popup menu. The Make Filter dialog is displayed.
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The Make Filter dialog with a sample filter

Match Conditions

The Match Conditions area of the dialog helps you set up the criteria that will
determine whether or not a particular message will get acted on by this filter. The
two match conditions reflect type and content.

You can specify that the type of messages you are interested in should be
Incoming and/or Outgoing. You can also specify that this should be a Manual
filter (described below). You can check and uncheck any combination of the three
boxes Incoming, Outgoing, and Manual.

• Incoming: If this box is checked, then any incoming message that satisfies the
content match condition you specify will be acted on according to the action
you’ve specified in this filter.

• Outgoing: If this box is checked, then any outgoing message that satisfies the
content match condition you specify will be acted on according to the action
you’ve specified in this filter.
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• Manual: If this box is checked, then when you select one or more message
summaries in a mailbox window and choose Filter Messages from the Special
menu, the incoming and/or outgoing messages selected that satisfy the content
match condition you specify will be acted on according to the action you’ve
specified in this filter. Whether the messages that are manually filtered by this
filter are incoming and/or outgoing messages depends on which other box or
boxes are checked: Incoming or Outgoing or both.

You can choose one of three content matches: From, Any Recipient, or Subject.

Click the From radio button (turned on by default) to match the message against
the From field—the sender—of the messages you selected. You can then edit the
field. The From field of a target message must contain the information in this box
but does not have to exactly equal it. Note that if you selected multiple messages
and they do not have a common sender, the From field is unselectable and is left
blank.

Click the Any Recipient radio button to match the message against any of the
recipients in the messages you selected (recipients are contained in the To and Cc
fields and, in an outgoing message, the Bcc field). Choose one recipient from the
pulldown menu (accessed from the menu button next to the field), or edit the text
in the field. Note that the information you enter in the field must be contained in
any of the recipient fields of the target message but does not have to exactly equal
any recipient field.

Click the Subject radio button to match the message against the Subject field of
the messages you selected. If you have selected multiple messages and they do
not have a common Subject, this field is left blank. In either case you can edit the
field. The Subject line of a target message must contain the information in this
box but does not have to exactly equal it.

Action Area

The Action Area lets you determine the one action that will be performed on
messages that satisfy the Match Conditions you’ve specified for this filter. The
three action choices are all message-transfer actions: they transfer the filtered
message to a mailbox. For messages that satisfy your match conditions, your
simple filter will transfer the messages to either a new mailbox, an existing
mailbox, or your Trash mailbox.

Click the Transfer to New Mailbox radio button to transfer the filtered message
to a new mailbox that you will specify. The text field is filled in with a suggested
new-mailbox name based on your selected content match condition (From, Any
Recipient, or Subject). You can change this name if you like. The In Folder field
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is a label showing you the folder in which your new mailbox will be created. By
default, this is the same folder that holds the mailbox containing the messages
you’ve selected. The new mailbox is created as soon as you create this filter.

Click the Transfer to Existing Mailbox radio button to transfer the filtered
message into one of your existing mailboxes. Select the mailbox from the button
next to the field. The default mailbox is the In box. When you click the button, a
version of the Transfer menu appears, letting you choose the mailbox from the
Transfer menu.

Click the Delete Message (Transfer to Trash) radio button to delete the message
that satisfies the filter match conditions, transferring it to your Trash mailbox.
This feature is useful for deleting junk e-mail, or “spam” as it is called in the
Internet world.

Buttons

• Create Filter: When you have set up your match conditions and filter action,
click Create Filter to create the filter. The filter is added to the bottom of your
filters list in the Filters window (discussed below). The filter is available
immediately and will act on messages that satisfy the conditions at the next
mail check, mail send, or selection of the Filter Messages command, as
appropriate.

• Add Details: Alternately, after setting up the filter information, click Add
Details to both create your filter and also open the Filters window so that you
can add additional information to your new filter and make it more powerful or
just change it. The filter is added to the bottom of your filters list and is
immediately available in the form in which it was set up in the Make Filter
dialog. Any changes you make in the Filters window must be saved before they
become effective. See below for more information on the Filters window.

• Cancel: Click Cancel to cancel the filter if you change your mind. The filter is
cancelled and your changes are not saved.

Detailed Filters with the Filters Window
The Make Filter dialog, discussed above, lets you create quick, simple filters that
perform one operation—a mail transfer—based on one match condition—a piece
of header information. The Filters window lets you create more complex,
powerful filters that use multiple match conditions and perform multiple filter
actions. (You can also use the Filters window to create simple filters such as those
created by the Make Filter dialog.)
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To open the Filters window, select Filters from the Tools menu, or click on the
Filters window’s tab if it is part of a visible tabbed window group. The Filters
window is displayed, and any filters you have created are listed on the left. (For
more information on how to manipulate the Filters window alone and as part of a
tabbed window, see the section “Managing Your Windows in Eudora.”)

The Filters window with an example filter

To create or modify a filter from the Filters window, first click on the New button
or select an existing filter.

Second, select the options for how you want the filter to be used: as an automatic
filter to be invoked on any Incoming and/or Outgoing mail, and as a Manual
filter that can be invoked when you select Filter Messages from the Special
menu. Any combination of these options works.
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Third, define the criteria for the filter: use the header item popups and the text
fields to specify which header items should include a particular string of text. You
can define two related terms for the criteria so that your filter is as specific as
possible (see the section “Filter Criteria”).

Fourth, define the action or actions to be taken on messages that fit the criteria
(see the section “Filter Actions”) and save the filters.

When the filters are invoked (automatically or manually), each message is
matched against each filter in order from top to bottom. If the message meets a
filter’s criteria, the actions are done as specified until there are no more actions,
then the message is matched against the next filter. If at any point a Skip Rest
action is done, the remaining actions for that filter (if there are any) are performed
on that message, the rest of the filters in the filters list are skipped for that
message, and the next message is filtered, again going from top to bottom down
the filters list.

You can change the width of the filters list to create more or less space for your
list. To do this, put the arrow over the bar to the right of the list and drag the line
to the left or right.

The next two sections refer exclusively to the Filters window. For information on
the match conditions and filter actions in the Make Filter dialog, see the section
“Quick and Simple Filters with the Make Filter Dialog.”

Filter Criteria (The Match Area)
Each filter in the Filters window can use one or two “terms” as its criteria,
connecting them as appropriate with the conjunction popup.

Use the Header field to specify which message header items you want the filter to
search. You can select an option from the popup menu or enter one yourself (this
is helpful if you want to use a header item that does not appear on the menu, such
as X-Priority). The selections are as follows:

• To:
• From:
• Subject:
• Cc:
• Reply-To:
• «Any Header»
• «Body»
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• «Any Recipient»
• «Personality»

The «Any Header» option searches all message headers (including hidden headers
that are shown with the BLAH BLAH BLAH option). The «Body» option
searches the message body. The «Any Recipient» option searches all possible
recipient items (To, Cc, Bcc). The «Personality» option searches the name of the
personality (e-mail account) associated with the message.

Use the Match Type popup to control how the header item is matched with the
text string in the text field. The match options are as follows:

contains or doesn’t contain
If the specified header item contains or does not contain the text string, filter the
message.

is or is not
If the specified header item is or is not an exact match of the text string, filter the
message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the
message. The starts with item refers to the first non-whitespace character after
the colon, so any spaces after the colon are ignored.

appears or doesn’t appear
If the header item appears or does not appear in the message, filter the message
(the text field is ignored). This is useful for filtering messages based only on the
types of fields they contain. Example: Some messages contain a Reply-To header,
some don’t.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a
nickname within the nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for.

Use the Conjunction popup to link the two terms. The conjunction options are as
follows:

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms (but not just one alone),
filter it.
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or
If the message matches either term (or both), filter it.

unless
If the message matches the first term, filter it unless the message also matches the
second term, in which case do not filter it. (This lets you exclude certain
variations of the first term.)

Filter Actions
For a filter you’re creating or modifying in the Filters window, all messages that
match the filter criteria are acted on as specified with the Actions popups. Each
filter can do up to five things to a message that matches the criteria. You can use
the same action twice if it does not directly affect the original message (for
example, Copy To can be used twice, but not Transfer To).

Some filter actions have an associated icon. For these actions, Eudora places the
action icon next to the filter in the filters list. Up to five icons can appear per
filter.

The Actions options are as follows:

None
No action.

Make Status
Assigns the selected status to message summaries.

Make Priority
Assigns the selected priority level to messages. If you select a set level, messages
are set to that priority. If you select Raise or Lower, messages are raised or
lowered one priority level based on their pre-filter level.

Make Label
Assigns the selected label to messages. Label colors and names are set in the
Labels Options.

Make Personality
Assigns the selected personality to messages. For outgoing messages, the
messages are not sent from the assigned personality, only from the personality
that was set when you composed the message. For incoming messages, all your
responses to the message will be from the assigned personality until you change
the personality associated with the incoming message or your response. For more
information, see the section “Using an Alternate E-mail Account.”
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Make Subject
Assigns the new subject to message summaries (does not affect the subject in the
message itself). If you choose this option, the entire subject of the message is
replaced with the new subject. Use the “&” symbol to stand for the old subject if
you want to add the new subject to the old subject. For example, entering New
Subject [was &] results in New Subject [was Old Subject].

Play Sound
Plays the selected sound when messages are filtered.

Open
Opens the Mailbox and/or Message when a message is received. If you set a
previous action to filter messages into a mailbox, then that mailbox is opened.

Print
Prints one copy of each message.

Notify User
Notifies you As Normal and/or In Report when messages are received. The As
Normal option notifies you based on the options you have selected in the Getting
Attention Options. The In Report option notifies you by opening the Filter
Report window and displaying in that window a filter report that details what
filter actions have been done. See the section “Filter Report Window.”

Notify Application
Notifies the selected application when messages are received, and provides
information from the message. Specify the application to use and the part of the
message to be included.

Use the Browse button to select an application, or enter the command line
yourself. The command line should include the path to the executable, any
options, and the following substitution variables, all separated by blank spaces:

%1 Date
%2 To
%3 From
%4 Subject
%5 Cc
%6 The entire message

For example, the command line to send the subject of a message to a pager might
look like this:

C:\apps\pager.exe -c %4

92 QUALCOMM Incorporated



Eudora User Manual Organizing Your Messages

Forward To
Forwards messages to the e-mail address given. Forwarded messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.

Redirect To
Redirects messages to the e-mail address given. Redirected messages are placed in
the queue in the Out mailbox, and sent the next time you send queued messages.

Reply with
Replies to messages with the selected stationery message. Replies are placed in
the queue in the Out mailbox and sent the next time you send queued messages.
One typical use of this action is to reply to specific senders with stationery telling
them that you’re on vacation: “I’m out till the 10th. I’ll reply to your message
when I get back.” For more details, see the section “Using Stationery.”

Server Options
Sets the message’s server status to Fetch and/or Delete (POP server only: see the
section “Managing Your Mail on the POP Server”).

Copy To
Copies messages to the selected mailbox.

Transfer To
Transfers messages to the selected mailbox.

Skip Rest
Stops filtering for the message (the message is not matched to the rest of the
filters in the filter list).

Sorting Messages Within Mailboxes
The message summaries in mailboxes are automatically sorted by date, in
ascending order (the newest messages at the bottom of the mailbox). To change
this, select the appropriate command from the Sort submenu under the Edit
menu. Or, click on any of the column headings to sort by that column. To sort in
descending order, hold down the Shift key and either select a command from the
Sort submenu or click on one of the column headings.
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The Sort submenu

Mailboxes are sorted based on the previous state of the mailbox. For example, if a
mailbox is sorted by Date, and then you sort by Sender, the messages are grouped
by sender and each group is in order by date.

See the Date Display Options in the Eudora Reference Manual for information on
age-sensitive indications that might appear in the Date column, such as the day of
the week or “Today.”

Finding Text Within Messages
Eudora incorporates a Find function that searches for specific text within a single
message, multiple messages, or even multiple mailboxes. To display the Find
submenu of commands, select Find from the Edit menu.

The Find submenu

Finding Text Within One Message
To search for text within a single message, open the message and make sure it is
current (active). Then, select Find from the Edit menu and select the Find
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command from the submenu. Or press Ctrl+F. The Find dialog is displayed, with
the blinking insertion point located in the text field.

In the text field, type the text you want to find. When finished entering the desired
text, click the Find button.

Finding text

Starting at the cursor’s current position in the message, Eudora searches the
current message for the specified text. If no match is found, the not found alert is
displayed.

If the search is successful, the message is scrolled to the first point where the
match is found and the matching text is highlighted.

To continue searching in the same message for the next occurrence of the text,
click the Find button in the Find dialog, or select the Find Again command from
the Find submenu (or press F3). These commands are equivalent and limit the
search to the same message. Repeating these commands cycles through the
matches in the open message only.

Finding Text Among Multiple Messages and Mailboxes
The Find command starts searching at the selected message in an open mailbox
window. If there is no open mailbox window, Find starts in your In box.

The Next, Next Message, and Next Mailbox commands are located on the Find
submenu (under the Edit menu) or as buttons in the Find dialog.

Next
The Next button (or Next command, shortcut Ctrl+;) allows you to search for the
next match of the specified text until it is found either in the same message or in
one of the following messages in the current mailbox.
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Next Message
The Next message button (or Next Message command) begins the search at the
message after the current message. Eudora continues to search until it finds a
matching character string, even if it has to open more than one message or a new
mailbox.

Next Mailbox
The Next mailbox button (or Next Mailbox command) begins the search for the
specified text in the mailbox following the current mailbox. The search is
conducted among all messages in that mailbox and any subsequent mailboxes,
including the In, Out, and Trash mailboxes.

Match Case
Normally, Eudora ignores capitalization when searching. If you want Eudora to
consider capitalization when searching, check the Match case option in the Find
dialog. When this option is checked, Eudora searches for exact matches of
character strings, including any capitalization.

Summaries Only
If you know that the text you are searching for is included in a message summary,
check the Summaries only option in the Find dialog. When you click the Find
button, Eudora searches for the text only in the Sender and Subject fields of
message summaries as they appear in mailbox windows. Eudora searches much
faster when this option is checked.

Enter Selection Command
If you don’t want to actually type the text in the Find dialog (for example, the text
is very long or complex), highlight it in an existing message, and then either select
Enter Selection from the Find submenu, or press Alt+F3. This automatically
inserts the selected text at the insertion point in the Find dialog. Then, click the
Find button in the Find dialog, or select the Find command from the Find
submenu, to start the search.

Stopping a Find
If you want to stop Eudora from continuing a search, click the Stop button in the
progress window, or press the Esc key.
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Saving a Message to a File
You can save a message to a separate text file on your PC. To do this, open or
select the messages you want to save. Then, select Save As... from the File menu.
The Save As dialog is displayed.

The Save As dialog

Enter the name you want to give the text file, and select the appropriate options.

Include Headers retains the first message’s header information in the saved
document. If this is not checked, only the body of the messages is saved.

Guess Paragraphs removes extraneous carriage returns from the message,
leaving returns only at the ends of paragraphs, and converts multiple spaces into
tabs.

Once you’ve made all of your choices, click on the Save button in the dialog.

If you select multiple messages from a mailbox window and select Save As..., all
of the messages are saved to a single file.
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Managing Your Windows
in Eudora

Introduction
This section discusses the window management features that are new as of Eudora
version 4.0.

Window States and Tabbed Windows
Every window in Eudora exists in one of three states:

• Normal

• Docked

• Floating

These states are described below.

A tabbed window is a collection of windows combined into a single window in
which each window has its own tab, for activating and dragging. A tabbed
window can exist in any of the three window states, normal, docked, or floating.
Tabbed windows are discussed separately below.

Note that only tool windows — those windows accessible from the Tools menu
(excluding the Options dialog) — can exist as docked windows, floating
windows, and tabbed windows. All other windows in Eudora, particularly
mailbox windows and message windows, exist only in the normal state and
cannot be combined into tabbed windows.

The tool windows that can be docked, floating, or tabbed are as follows, in order
down the Tools menu:

• Filters Window

• Filter Report Window

• Mailboxes Window

• File Browser Window
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• Stationery Window

• Signature Window

• Personalities Window

• Address Book

• Directory Services Window
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Normal Windows
A window is said to be in the normal state if it is restricted to the window work
area of the main Eudora window, and cannot be dragged out of the main window.

Sample normal windows inside the main Eudora window

Normal windows can be moved around within the window work area. They can
also be minimized, and can be maximized to completely fill the visible window
work area. When a normal window is maximized, its title bar partially blends with
the main window title bar.

Normal windows can overlap other normal windows and are obscured by both
docked and floating windows.

The title bar of a normal window contains the window-menu icon (far left) and
three window buttons: minimize/restore, maximize/restore, and close.
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A tool window in the normal state, whether alone or in a tabbed group, can be
dragged out of the confines of the main Eudora window, but it must first be
converted to a dockable or floating window. To perform this conversion, right-
click on the window’s border or tab, uncheck (turn off) Float In Main Window
on the context menu, then select (turn on) Allow Docking on the menu.

A non-tool window in the normal state, such as a mailbox window or a message
window, can never be dragged out of the confines of the main Eudora window.

To convert a docked or floating window to a normal window, right-click on the
docked or floating window’s border or tab, and select Float In Main Window
from the context menu.
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Docked Windows
A window is said to be dockable if it is capable of being attached to one of the
four edges of the main Eudora window. A window is said to be in the docked state
if it is currently attached to one such edge.

Sample windows docked to the main Eudora window (left and bottom edges)

Only tool windows (as described above), whether alone or tabbed, are dockable.
All other windows in Eudora, particularly message windows and mailbox
windows, are not dockable.

Dockable windows can be docked to any edge of the main Eudora window and to
each other. You can also dock multiple windows along a single edge of the main
window.

QUALCOMM Incorporated 103



Managing Your Windows in Eudora Eudora User Manual

When you dock a window to the main window, the visible window work area is
reduced. Docked windows cannot be obscured by normal windows, but they can
be obscured by floating windows.

To make a window dockable, right-click on the window’s border or tab, make
sure the Float In Main Window command is unchecked (off) on the context
menu, and select (check) the Allow Docking command on the menu.

To then dock the window, drag the window to an edge of the main Eudora
window or to another docked window, and when the ghosted docking rectangle
appears, indicating that the window will be docked, release the mouse button. The
window attaches to the main window edge or the other window.

Some windows are more convenient to use when docked vertically (tall-and-
skinny), while others are more convenient to use when docked horizontally (short-
and-wide). Examples of windows that work better as tall-and-skinny windows are
the Mailboxes window and the File Browser window. Examples of windows that
work better as short-and-wide windows are the Personalities window and the
Filter Report window.

Following are descriptions of the controls in docked windows.

The Gripper Bar
The gripper bar, also called the grab handle, is the double line at one edge of the
docked window. Drag the window by the gripper bar to undock it from the main
window frame. The window now floats: you can leave it as a floating window, or
you can dock it to any edge of the main window or to another docked window.

The Zoom Button
When two or more windows are docked on the same edge of the main window,
Eudora activates each window’s zoom button. This button appears next to the “x”
close button and contains a small triangle. Click the zoom button to minimize,
maximize, or restore the width or height of that docked window relative to the
other docked windows adjacent to it.

The Close Button
The close button contains an “x” and appears next to the zoom button. Click the
close button to close the docked window.

The Resize Bar
When two windows are docked side by side along one edge of the main window,
a bar appears between them, called the resize bar. Drag this bar up or down, or to
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the left or right, as appropriate, to enlarge one of the docked windows and reduce
the other.

Floating Windows
A window is said to be in the floating state if it floats above the main Eudora
window and can be placed anywhere on the desktop, including outside the main
Eudora window. In this way a floating window is a standard Windows “Always
on Top” window, like tool palettes in paint programs.

Sample floating windows

Only tool windows (as described above), whether alone or tabbed, can be made to
float. All other windows in Eudora, particularly message windows and mailbox
windows, cannot be made to float.

All windows in Eudora can be thought of as “living” in one of three layers or
areas:

• Normal windows live in the window work area, at the bottom layer
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• Docked windows live at the level of the main Eudora window’s border, the
middle layer

• Floating windows live at the level above the main Eudora window, the top
layer

Therefore, a floating Eudora window floats above all other Eudora windows
except other floating windows.

The title bar of a floating window contains, in addition to the title, only the close
button. This distinguishes the window from a normal window when both appear
to be in the window work area: a normal window’s title bar contains the window-
menu icon (left) and three buttons. But also note that a floating window can be
dragged outside of the main Eudora window, whereas a normal window cannot.

You can diagonally resize any floating window in Eudora. Simply position the
pointer over any window corner, click and drag to enlarge or reduce.

To convert a window to a floating window, either undock it from the main
window, if it is docked, or do the following: right-click on the window’s border or
tab, make sure the Float In Main Window command is unchecked (turned off)
on the context menu, then turn off (uncheck) the Allow Docking command on the
menu. For a docked window, you can also temporarily override the Allow
Docking command and suspend docking by holding down the Ctrl key while
dragging the window. The window drags as a floating window.
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Tabbed Windows
A tabbed window is a collection of tool windows combined into one window.
Each tool window in the tabbed window has its own window tab.

Sample tabbed windows: one docked (left), one normal

A window tab has two purposes: It lets you bring the window to the front of the
group to display it (by clicking on the tab). It also serves as a “drag handle” that
lets you drag the tool window from one tabbed window to another, so that you can
reorganize your tabbed windows and create new tabbed windows.

Only tool windows, as described above — that’s all windows accessible from the
Tools menu, except the Options dialog — are capable of being combined into a
tabbed window. All other windows in Eudora — particularly mailbox windows
and message windows — are not capable of being combined into a tabbed
window.

A tabbed window can be in any of the three window states, normal, docked, or
floating, and you can convert a tabbed window from any state to any other state.
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If a tabbed window shows a title bar, the title in the bar is the name of the active
window in the group.

Eudora’s Default Tabbed Windows
Eudora comes with two default tabbed windows, shown in the figure above,
which together include all nine tool windows.

The first default is a vertically oriented tabbed window that is docked to the left
side of the main window and contains the following five tool windows, with tabs
in left-to-right order:

• Mailboxes Window

• File Browser Window

• Stationery Window

• Signature Window

• Personalities Window

The second default tabbed window is a normal window that contains these four
tool windows, with tabs in left-to-right order (to display this window, display one
of the member windows from the Tools menu):

• Directory Services Window

• Address Book

• Filters Window

• Filter Report Window

As described further below, you can reorganize these default tabbed windows any
way you like. Your new organization will be preserved when you quit and restart
Eudora.
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Opening and Activating Tabbed Windows
To open a tabbed window that’s hidden, open any of its member windows by
selecting the appropriate command from the Tools menu. The tabbed window
opens with the selected window as the active (frontmost) window.

If the tabbed window is already visible and you wish to display one of its member
windows that is currently not active, simply click on the member window’s tab.
You can also select the appropriate item from the Tools menu. The desired
window comes to the front of the tabbed group.

You can also use the tool window’s keyboard shortcut, if it has one, to open or
activate the tool window in its tabbed window.

Reorganizing Tabbed Windows
You are not restricted to the default tabbed window arrangements supplied with
Eudora. You can mix and match tabbed windows any way you like.

At one extreme, you can have each of the nine tool windows in its own container
with its own tab. At the other extreme, you can have all nine tool windows
combined into one tabbed window. In between, you can have multiple tabbed
windows open at once, mixed and matched to suit your purposes.

To move a window from one tabbed group to another, drag the window tab from
the first group and drop it onto the second.

While the drag operation is in progress, the cursor changes and Eudora displays a
small ghosted rectangle when you are over a valid drop location.

If you drop the window tab onto another tab in the second group, the new window
tab is inserted at that position and the other tabs are displaced to accommodate it.
If you don’t drop the tab onto an existing tab, Eudora adds the new tab at the
“end” of the group of existing tabs, where that end depends on the location of the
tabs in the tabbed window: top, bottom (the default), left, or right. For example,
with tabs along the bottom, the “end” is the far right.

Note that the relocated window takes on the window state — normal, docked, or
floating — of the destination tabbed window.

To reorganize the left-to-right or top-to-bottom order of tabs within a tabbed
window, just drag the tabs left and right or top and bottom. The drop scheme is
the same as that described above.
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Creating a New Tabbed Window
To create a new tabbed window, drag one of the tabs from an existing tabbed
window and drop it onto an exposed portion of the window work area. If the
window work area is completely obscured — a normal window is maximized, for
example — then drop the tab onto the status bar.

The dropped window converts into a normal tabbed window with a single tab. To
convert the window to docked or floating, right-click on the tab or the window
border, and uncheck Float In Main Window on the context menu. Check the
Allow Docking command on the menu to make the window dockable. While
dragging the floating or docked window, hold down the Ctrl key to temporarily
suspend docking behavior. When you release the key, docking behavior resumes.

Tab Display in Single-Tabbed Windows
If a tool window is in a tabbed window by itself, with one tab, you can hide or
show the tab by right-clicking on the tab or the window border to display the
context menu, then selecting Show Single Tab from the Tab Location submenu.

Tab Contents, Location, Auto-Activation
• Tab Contents — A window tab contains both the icon and the text label

associated with that window. If there is room enough in the tabbed window,
both the icon and the label are displayed on each tab. If there is not enough
room, only the icon is displayed for each tab. If only the icon is visible, pause
the mouse pointer over the tab icon and Eudora will display the tab text in a
tooltip.

• Tab Location — By default, Eudora arranges window tabs along the bottom
edge of a tabbed window. Sometimes, however, it is more convenient to have
the tabs displayed along a different edge. For example, in a short-and-wide
tabbed window (one that is docked horizontally), you can improve the visibility
of the window’s contents by moving the tabs to the right edge. To change the
location of the tabs in a tabbed window, right-click on one of the tabs or on the
window border, and select a new location from the Tab Location submenu of
the context menu.

• Tab Auto-Activation — During a drag and drop operation, if you pause the
mouse pointer over the tab of an inactive window in a tabbed window, that
window becomes active (is brought to the front), and you can complete the
drop. For example, if you drag received messages to the Mailboxes window
when it is inactive in a tabbed window, pause the pointer over the Mailboxes
window’s tab: the window is made active and you can drop the messages in a
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mailbox. Note that tab auto-activation is disabled when you are dragging a tool
window tab.

Closing Tabbed Windows
To close a tabbed window, click the “x” close button in the corner of the window.

Alternately, right-click on any tab in the window, or on the window border, and
select Hide from the context menu.

Note that when you close or hide a tabbed window, the contents of all member
windows, and the state and position of the tabbed window, are all preserved.
When you redisplay the tabbed window, the active window shows its prior
contents and the tabbed window appears in its prior state and position.

However, if you attempt to close or hide a tabbed window in which the active
window contains unsaved changes, or you attempt to deactivate that active
window by making another window active in the group, Eudora asks you if you
want to save your changes.

The Window Context Menu
If you right-click on the tab or border of a single tool window, or on any tab or the
border of a tabbed window, Eudora displays a context menu containing window-
management commands.

Window context menu

The commands on the context menu are described below.

Note that if you right-click in the interior of some tool windows, and sometimes
on an item in the window itself, these window-management commands appear at
the bottom of the context menu specific to that tool window.
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Tab Location
This submenu is always available on the window context menu. It lets you change
the location of the tabs in a tabbed window, and lets you show and hide the tab in
a single-tabbed window.

By default, Eudora places window tabs at the bottom of a tabbed window. Choose
Top, Bottom, Left, or Right from this submenu to move the tabs to the top of the
tabbed window, the bottom, or the left or right side. Eudora places a bullet (radio
button) next to the current tab location selection.

Changing tab locations can sometimes increase the visible space within a tabbed
window. For example, a short-and-wide tabbed window (one docked horizontally)
might show more content if you move the tabs to the right side.

Show Single Tab is available in a single-tabbed window, and lets you show or
hide the tab. A checkmark next to the command indicates that the tab is shown
(the default). This command is not available in a tabbed window containing two
or more tabs: you cannot hide the tabs in such a window.

Allow Docking
This command controls the dockability of floating and docked windows. It is
available only when the Float In Main Window command is turned off
(unchecked). It is not available for normal windows (i.e., when Float In Main
Window is turned on).

A checkmark next to the command indicates that it is on.

When this command is on for a docked or floating window, the window can be
docked to any edge of the main Eudora window.

When Allow Docking is turned off for a docked window, the window is
converted to a floating window and cannot be redocked. When the command is
turned off for a floating window, the window cannot be docked.

Even with Allow Docking on, you can hold down the Ctrl key while dragging a
docked or floating window to suspend dockability until you release the key.

Hide
This command is always available on the context menu.

Select Hide to hide (close) the tool window or tabbed window. Hide performs the
same function as the Close command (Ctrl+F4) on the standard MS Windows
window context menu.
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Note, however, that when you hide or close a tool window, its content, state, and
position are all preserved. And when you hide or close a tabbed window, the
content, state, and position of all member windows are preserved. Thus, if you
hide and redisplay a floating tabbed window, the window floats in its same
position.

If you attempt to hide or close a tool window that contains unsaved changes, or a
tabbed window in which the active window contains unsaved changes, Eudora
asks you if you want to save your changes.

To redisplay a tool window after you’ve hidden it, select it from the Tools menu.
To redisplay a tabbed window after you’ve hidden it, select one of its member
windows from the Tools menu. The tabbed window redisplays with the selected
window active. You can use keyboard shortcuts to redisplay hidden tool or tabbed
windows where appropriate.

Float In Main Window
This command is always available on the context menu.

Turning this command on (indicated by a checkmark next to the command)
converts a docked or floating window to a normal window. Turning this command
off converts a normal window to a docked or floating window.

Note that the availability of the Allow Docking command depends on the state of
this command. When Float In Main Window is turned on (checked), Allow
Docking is unavailable (the window is normal). When Float In Main Window is
turned off, Allow Docking is available.

Using the Eudora Taskbar
The Eudora taskbar appears along the bottom edge of the window work area in
the main Eudora window, and normally shows the QUALCOMM logo at the
right.

Sample Eudora taskbar (with status bar below it)

The Eudora taskbar displays a button for each normal Eudora window that is open
or minimized. The taskbar provides a convenient way to switch between normal
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windows by clicking buttons, without having to display the different windows
from the Window menu.

The Eudora taskbar is modeled after the Windows 95 and Windows NT 4.0
system taskbars, which usually appear at the bottom of the screen — but there are
important differences, noted below.

To show or hide the Eudora taskbar: Select Options... from the Tools menu to
open the Options dialog. Then select the Display option category. Then click the
Show MDI task bar option on or off.

Any normal Eudora window that is open or minimized is represented by a button
on the taskbar. This includes composition messages, received messages, mailbox
windows, and any tool windows or tabbed windows that are in the normal state.
Any open tool or tabbed windows that are in the docked or floating state are not
represented as buttons on the taskbar.

If a tabbed window is represented by a button on the taskbar, the button shows the
name and icon associated with the active tool window in that tabbed window.

Click on a taskbar button to make that normal window active. The window comes
to the front of the stack of all normal Eudora windows.

If you right-click on a taskbar button, the standard Windows context menu
displays, letting you Restore, Minimize, Maximize, or Close that normal window.

If you right-click on an exposed area of the taskbar (not on a button), the standard
Eudora context menu displays.

If you drag an object over a taskbar button and pause for several seconds, Eudora
activates the normal window associated with that button. For a tabbed window,
Eudora activates the tabbed window with the indicated window active. You can
then complete the drag and drop operation into the normal window. For a tabbed
window, you can further pause the pointer over one of the inactive window tabs,
and that window becomes active and you can complete the drop.

Each taskbar button displays both the window icon and the window title of the
normal window. If there is not enough room to display the entire title, Eudora
truncates the title and places an ellipsis (...) to indicate the truncation. If you pause
the mouse pointer over such a button, Eudora displays the entire window title in a
tooltip.

If you have many normal windows open or minimized, the taskbar buttons shrink
so that all buttons are visible. When the bar gets sufficiently crowded, the
QUALCOMM logo is hidden to make room.
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Note that, unlike with the Windows 95 and Windows NT 4.0 taskbars, you cannot
move the Eudora taskbar to another edge of the main Eudora window: it always
stays at the bottom of the window work area. You also cannot resize the taskbar
as a separate item. It resizes automatically, however, when you resize the main
Eudora window.

New Tool Windows
The following tool windows are new as of Eudora version 4.0, and are available
from the Tools menu.

Filter Report Window
If the Generate Filter Report option is turned on in the Getting Attention
Options, then when filters are used, Eudora generates a filter report. This report
can be viewed in the Filter Report window.

To open the Filter Report window, select Filter Report from the Tools menu. Or,
if the Filter Report window is in a visible tabbed window, click its tab.

Sample Filter Report window

If filter report generation is enabled via the option mentioned above, then each
time a filter operation is performed, Eudora adds the entry or entries to the Filter
Report window and activates the window.

QUALCOMM Incorporated 115



Managing Your Windows in Eudora Eudora User Manual

The Filter Report window displays three columns of data:

• Mailbox — Lists the names of the mailboxes into which messages have been
filtered during the current Eudora session. Each listing represents one filter
operation for that mailbox.

• Messages — For each mailbox listed in the Mailbox column, lists the number
of messages filtered into that mailbox during the filter operation.

• Time — For each mailbox listed in the Mailbox column, lists the time that the
messages were filtered into that mailbox during the filter operation.

By default, the entries in the window are sorted by time. However, you can click
the column headings and sort the display by mailbox names (Mailbox) or by the
number of messages filtered (Messages).

Select one or more entries in the list and double-click the selection, or press
Enter, and Eudora opens the mailbox windows associated with those selections.

The Filter Report listing is a cumulative log of the filter actions for the current
Eudora session. Eudora automatically clears the log when you quit the program.

Closing the Filter Report window does not erase the contents of the filter report,
as it did in previous versions of Eudora. Only quitting Eudora erases this
information.

File Browser Window
Use this window to browse the Windows desktop. You can use this window to
find files to attach to new outgoing messages, for example.

To open the File Browser window, select File Browser from the Tools menu. Or,
if the File Browser window is in a visible tabbed window, click its tab.
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Sample File Browser window

The File Browser window performs some, but not all, of the functions of the
standard Windows 95 and Windows NT 4.0 Explorer programs.

The File Browser window contains three controls:

• Drive Selector (top box) — A popup menu in this field contains a fixed set of
high-level folders on your system, just like the corresponding control in
Windows Explorer. The Drive Selector field determines what gets displayed in
the Folder Browser (middle section). When you first launch Eudora, the Drive
Selector automatically sets itself to the drive containing your Windows folder.
Note that the first entry in the popup menu is a shortcut called “My
Attachments” that points to your Eudora attachments folder.

• Folder Browser (middle section) — This is a tree control that displays the
folder hierarchy whose root is the selection entered in the Drive Selector field.
For example, if in the Drive Selector box you choose the C: drive, then the
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Folder Browser displays the folder tree-hierarchy branching down from the C:
drive folder. Right-click a folder item in the Folder Browser to display the
standard Windows context menu for that folder.

• File List (bottom section) — This is a list control that displays the files
contained in the folder selected in the Folder Browser. You can select one or
more file items in the list, then right-click on the selection to display the
standard Windows context menu for those files. (Note: Eudora does not fill in
the Send To submenu on the context menu.) When selecting multiple items, use
the Shift key to select a range of items, and use the Ctrl key for disjoint
selections.

The File List control shows these four columns:

• Name — Displays the name of the file and the icon associated with the file.

• Type — Based on the file name extension, displays the file type as set in the
Options dialog of Windows Explorer.

• Size — Displays the size of the file in kilobytes (K), where 1K = 1,024 bytes.

• Modified — Displays the date and time that the file was last modified.

As in Windows Explorer, you can click any of the four column headings to sort
the listing by the data in that column.

You can also resize the widths of the columns by dragging the separator line
between the column heading labels. Position the pointer over the separator until
you see a splitter cursor, then drag the line to left or right.

In the File List control, double-click an item in the Name column, or select one or
more items in the column and press Enter, to open the selected items. For
program files, this action launches the program. For document files, this action
generally launches the registered viewing or editing application for that document.
Eudora displays an error dialog if it is unable to open a file in this way.

To adjust the relative heights of the Folder Browser and File List controls,
position the pointer over the separator bar between the Folder Browser and File
List controls until the splitter cursor appears, then click and drag the separator up
or down. Note that the File Browser window maintains a minimum height for the
Folder Browser and File List controls, so you cannot close them all the way.

To manually refresh the File Browser window display, right-click anywhere in the
File Browser window but not on a Folder Browser item or File List item, then
select Refresh from the context menu. (Tip: A good place to right-click is in the
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Drive Selector box.) Alternately, press the F5 key while keyboard focus is in the
File Browser window.

You can select one or more files in the File List control and drag them to a
message composition window to attach those files to that outgoing message. This
is especially handy if you keep the File Browser window docked and open. (For
multiple file selections, use the Shift key to select a range, and use the Ctrl key to
make disjoint selections.)

You can also select one or more items in the File List control and drag them to
another application that can receive such files.

In general, the File Browser window lets you drag items out of the window
(copying them rather than moving them), but the window is not a proper drop
target: you cannot drop items into the window that you’ve dragged from
elsewhere on your desktop. In particular, you cannot move files by dragging them
to a target folder in the Folder Browser control. You also cannot drag and drop
items within the File Browser window (from one control to another, for example).
You can, however, manage the files and folders in the window using the
commands on the window’s context menu, such as Cut, Copy, Paste, and Delete.
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Stationery Window
Use this window to manage and apply stationery.

To open the Stationery window, select Stationery from the Tools menu. Or, if the
Stationery window is in a visible tabbed window, click its tab.

Sample Stationery window

The Stationery window displays a single-column list of your stationery files.

If you right-click on a stationery item in the list, a context menu is displayed with
the following commands (the standard Eudora window-management commands
appear at the bottom):

• New... — Create a new piece of stationery (a new stationery file). An untitled
stationery window opens that you can fill out and Save As Stationery from the
File menu.

• Edit — Open an editing window for the selected stationery item. Make your
changes and Save As Stationery from the File menu, or close without saving
to discard your changes.

• Delete — Delete the selected stationery item. Eudora asks you to confirm the
deletion. Use the Del key (Delete) as a shortcut for this command.
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• Rename — Rename the selected stationery file. Use the F2 key as a shortcut
for this command, or click on the stationery file’s name box, then edit the name
right in the box.

• New Message With — Create a new message with the selected stationery. As
a shortcut for this command, either select the stationery item and press Enter,
or just double-click the stationery item.

• Reply With — Reply with the selected stationery to the sender(s) of the
received messages that are currently selected.

• Reply to All With — Reply with the selected stationery to the sender(s) and all
recipients of the received messages that are currently selected.

You can also display the context menu and create new stationery by right-clicking
anywhere in an empty Stationery window or by right-clicking anywhere off a
stationery item in a non-empty Stationery window.

Signature Window
Use this window to manage and apply signatures.

To open the Signature window, select Signatures from the Tools menu. Or, if the
Signature window is in a visible tabbed window, click its tab.

Sample Signature window

The Signature window displays a single-column list of your signature files.
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If you right-click on a signature in the list, a context menu is displayed with the
following commands (the standard Eudora window-management commands
appear at the bottom):

• New... — Create a new signature. Eudora prompts you for the name of the new
signature, then opens an editing window for you to type the signature text. Save
the text with the File menu Save command, or close without saving to discard.

• Edit — Open an editing window for the selected signature. Double-click on a
signature as a shortcut for this command. Save your changes with the File
menu Save command, or close the window without saving to discard your
changes.

• Delete — Delete the selected signature. Eudora asks you to confirm the
deletion. Use the Del key (Delete) as a shortcut for this command.

• Rename — Rename the selected signature. Use the F2 key as a shortcut for
this command, or click on the signature item’s name box, then edit the name
right in the box.

You can also display the context menu and create a new signature by right-
clicking anywhere in an empty Signature window or by right-clicking anywhere
off a signature item in a non-empty Signature window.
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Personalities Window
Use this window to manage, access, and apply your e-mail accounts —
“personalities” — when you use more than one account.

To open the Personalities window, select Personalities from the Tools menu. Or,
if the Personalities window is in a visible tabbed window, click its tab.

Sample Personalities window

The Personalities window displays two columns of data:

• Persona — The identifying name assigned to the personality. <Dominant>
indicates your principal e-mail account, which is the account Eudora uses
whenever you don’t specify otherwise, and is the account associated with all
mail stored before you began using alternate personalities.

• Account — The incoming mail account assigned to the personality. This is
generally in the form loginname@incomingmailserver. (See “Account Settings
Dialog” below.)

To resize the column widths, position the pointer over the divider line between the
column headings, until a splitter cursor appears. Then just drag the divider to left
or right. Note that it is possible to completely collapse the Persona column.

If you select one or more personalities in the Persona column and right-click on
the selection, a context menu is displayed with the following commands (the
standard Eudora window-management commands appear at the bottom):

• Check Mail — Check mail now for all selected personalities.

QUALCOMM Incorporated 123



Managing Your Windows in Eudora Eudora User Manual

• Send Queued Messages — Send messages queued by all selected personalities
now.

• Message — This submenu lets you perform message-creation functions using
only one selected personality. The submenu is unavailable if multiple
personalities are selected in the Persona column.

- New Message As — Create a new message as the selected personality. As a
shortcut for this command, double-click on a personality in the Persona
column, or select the personality and press Enter.

- Reply As — Reply as the selected personality to the sender(s) of the one or
more received messages that are currently selected.

- Reply to All As — Reply as the selected personality to the sender(s) and all
recipients of the one or more received messages that are currently selected.

- Forward As — Forward as the selected personality the one or more received
messages that are currently selected.

- Redirect As — Redirect as the selected personality the one or more received
messages that are currently selected.

- Send Again As — Resend as the selected personality the one or more
received or composition messages that are currently selected.

• New... — Create a new personality. When you select this command, Eudora
walks you through the New Account Wizard. Enter a Personality Name (e.g.,
My Laptop Account) and click Next. You then have the choice to create a new
e-mail account or import the settings from an existing e-mail account — that is,
“clone” an existing personality. If you choose a new e-mail account, Eudora
prompts you for your name, your return e-mail address, your login name, and
your incoming e-mail server (POP or IMAP). Fill in each item as instructed. If
you choose to import the settings from an existing e-mail account (clone a
personality), Eudora asks you to choose the account to clone, then asks you to
confirm the settings and optionally change them. If you leave them unchanged,
the cloned account is created when you click Finish. If you choose to change
them, Eudora walks you through the settings as above: name, return address,
login name, and incoming e-mail server. Change these settings as desired, and
when you are complete, the new account is created.

• Modify... — Modify the selected personality. You can only modify one
personality at a time. When you select this command, the Account Settings
dialog displays, with its fields filled in with the information associated with
that personality. See the description of this dialog below.
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• Delete — Delete all selected personalities. Note, however, that you cannot
delete the <Dominant> personality. You are prompted to confirm the deletion
for each personality you have selected to delete. Note that these deletions are
permanent and cannot be undone! When you delete a personality, any
messages associated with that personality are reassigned to your Dominant
personality. You can use the Del key (Delete) as a shortcut for this command
(you will still get the confirmation requests).

You can also display the context menu and create a new personality by right-
clicking in a blank area of the Personalities window, off all personality items,
when none of the items are selected. When creating a new personality this way,
you are walked through the New Account Wizard as in the description of the
New... command above.

If you drag one or more received messages to a personality item in the
Personalities window, Eudora will Reply As that personality to the messages
(hold down the Ctrl key to Reply to All As).

Account Settings Dialog

The Account Settings dialog replaces the Personalities panel of the Options dialog
that appeared in previous versions of Eudora.

This tabbed dialog appears when you select Modify... from the context menu in
the Personalities window (see above). When you display the dialog, its fields are
filled in with the information associated with the personality you have selected to
modify.
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Sample Account Settings dialog (Generic Properties tab)

The fields of the Account Settings dialog are described below. Where appropriate,
the default value of the setting for newly created accounts is shown in brackets
after the name of the setting.

After you make your changes in the dialog, click OK to save them, Cancel to
discard them, or Help for more help.

Generic Properties:
This panel contains the general characteristics associated with this personality.

Personality Name
This is a label that shows the name assigned to the personality being modified
(e.g., Beatrix at Work, or My PC Account). <Dominant> indicates your dominant
personality.

Note that the name shown here may be different from the Real Name associated
with the personality (see below).
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Traits:

Real Name
This is the real name assigned to this personality—generally a first and last name.
The text you enter here is included in the From field of all your outgoing
messages from this personality, and identifies to your recipients who the mail is
from.

Return Address
This is the return e-mail address used in outgoing messages and recipients’ replies
for this personality, if this address is different from the personality’s incoming
mail account. The address you enter here is included in the From field of all your
outgoing messages from this personality, and when a recipient replies to a
message from this personality, the reply is sent to this address. If you do not enter
an address in this field, Eudora uses the personality’s incoming mail account as
the return address. Incoming mail accounts are usually of the form
loginname@incomingmailserver. For example, suppose your incoming mail
account is beatrixp@wabbits.qualcomm.com but your return address is
beatrixp@qualcomm.com — slightly different. You would then enter
beatrixp@qualcomm.com in this field.
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Login Name
This is the name you use to login to this e-mail account, for accounts that require
a user login. For example, in the incoming mail account
beatrixp@wabbits.qualcomm.com, the login name is beatrixp. (The part after
the “@” sign is the name of the incoming mail server — see the “Incoming Mail”
panel below.)

SMTP Server
This is the name of the outgoing-mail server for this personality. SMTP stands for
Simple Mail Transfer Protocol. Outgoing messages you send are routed through
this server. If the computer that this personality’s incoming mail account is on
also runs an SMTP server, you can leave this field blank.

Default Domain
This is the domain name that Eudora automatically adds to an unqualified name
addressed in messages sent from this personality. An unqualified name is a name
that doesn’t have an “@” sign followed by a domain name. This can be used to
save time when addressing large numbers of messages to users in the same
domain. Also, different personalities can be used to send messages to different
domains. For example, you can use one personality to send work-related messages
to the domain qualcomm.com, and another personality to send personal messages
to the domain in your home e-mail address, or to your school account, e.g.,
myschool.edu.

Default Stationery [<No Default>]
The default stationery to use for all outgoing messages sent from this personality.
Select a stationery file from the popup, or select <No Default> for no default
stationery. For more details about using stationery with alternate personalities, see
the sections “Using Stationery,” “Sending Mail Options,” and “Stationery
Window.”

Default Signature [<No Default>]
This sets the default signature to use for all outgoing messages sent from this
personality, but only when you are not using stationery — that is, only when the
Default Stationery popup (above) is set to <No Default>. If you have chosen a
stationery file in the above popup, then the signature used when that stationery
file was saved overrides your setting here.

Select a signature from this popup, or select <No Default> for no default
signature. If you select a signature, Eudora automatically attaches that signature to
the end of all outgoing messages sent from this personality. You can always
change the signature in a particular outgoing message using the Signature popup
in the composition window. For more details about using signatures with alternate
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personalities, see the sections “Using a Signature,” “Sending Mail Options,” and
“Signature Window.”

Check Mail [on]
If this is on, mail checking is activated for this personality in the following ways:

• If you have specified a number in the Check for mail every ? minutes option
in the Checking Mail Options, then when automatic mail-checks are performed
at these intervals, mail for this personality is checked too.

• Each time you do a manual check for mail, by selecting the Check Mail
command from the File menu or via another method, mail is checked for this
personality too.

If this option is off, mail for this personality is not checked during manual or
automatic mail-checks, except that you can override the setting and still check for
the personality’s mail using the Mail Transfer Options dialog or using the Check
Mail command from the Personalities window’s context menu.

Sample Account Settings dialog (Incoming Mail tab, POP configuration)
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Incoming Mail:
This panel contains settings that identify and configure the incoming mail server
to be used in receiving mail for this account.

Server
This is the name of the incoming-mail server for this personality. All incoming
messages to this personality are routed through this server.

Configuration [POP]
This indicates which e-mail protocol the incoming mail server uses: POP (Post
Office Protocol) or IMAP (Internet Message Access Protocol). Ask your e-mail
administrator which one to use, if you are not sure.

The settings in the rest of this panel depend on whether you’ve chosen POP or
IMAP in this field. Settings for both configurations are described below.

When Configuration = POP:

Leave mail on server [off]
If this is on, then during mail checks, incoming mail for this personality is left on
the incoming mail server and a copy is transferred to your PC. If this is off, then
when mail is checked, incoming mail for this personality is deleted from the
incoming mail server after it is transferred to your PC. For more details, see the
section “Managing Your Mail on the POP Server.”

Delete from server after ? days [off, 0]
This option has a check box for turning it on and off and an edit box for
specifying the number of days mail that was left on the POP server should be
saved before being deleted. It is a good idea not to leave copies of your messages
on the POP server indefinitely, as this will create mail storage problems on the
server.

Delete from server when emptied from Trash [off]
If this is on, any messages that are deleted from your Trash mailbox are also
deleted from the POP server. For details, see the section “Managing Your Mail on
the POP Server.”

Skip messages over ? K in size [off, 40]
If this is on, messages over the specified size are downloaded only in part. These
messages include the first few lines, and a statement that says the message is not
complete. This can be useful on slow connections. For details, see the section
“Managing Your Mail on the POP Server.”
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Authentication style [Passwords]
This specifies which POP account authentication technology to use for this
personality: Passwords, Kerberos, APOP, or RPA. Ask your e-mail administrator
which one to use.

When Configuration = IMAP:

IMAP Mailbox Location Prefix
This specifies the mailbox location prefix that IMAP will use when locating your
mailboxes on the incoming mail server. An example prefix is /usr/mail. Ask your
e-mail administrator what to enter here, if you are not sure.

Download Options:
These two settings let you control the way incoming mail is downloaded from the
IMAP server.

Minimal Headers Only [on]
If this setting is on, only a limited set of message headers is downloaded for each
incoming message. If this setting is off, the full set of message headers is
downloaded for each incoming message.

Skip Attachments over ? K [off, blank]
If this setting is on and a number is entered in the edit box, then any attachments
larger than the specified size will not be downloaded with the message. If this
setting is off, all attachments are downloaded, regardless of size.

Authentication style [Passwords]
This specifies which IMAP account authentication technology to use for this
personality: Passwords or Cram-MD5. Ask your e-mail administrator which one
to use.
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Using the Address Book
and Quick Recipient List

Using the Address Book
The Address Book is where you keep information about individuals or groups that
you correspond with. Each entry in the Address Book includes a nickname for a
person or group, their full e-mail addresses, a real name, any contact information,
and any notes. You can also use the Address Book to put nicknames on the Quick
Recipient List, and to address a new message.

To open your Address Book, select Address Book from the Tools menu, or press
Ctrl+L. Or, if the Address Book is an inactive window in an open tabbed window
group, click its tab. (See the section “Managing Your Windows in Eudora” for
more details on tabbed windows.)

The Address Book with example entries
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All of the Address Book entries are kept in files. The example above shows files
for Business, Family, and Friends (Eudora Nicknames is the default file). You can
show or hide the entries in a file by double-clicking on the file. The icon shows an
open or closed book, depending on whether the file is open or closed.

You can use the View By option to display the entries using any of the fields
except the Notes field. For example, if you want to view the entries by nicknames,
select View By Nickname. If you view by a field that doesn’t contain any data,
the entry is displayed with «».

You can also start typing in the list of entries, and the appropriate entry will be
selected when you enter enough unique characters to identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list,
drag the divider.

To close and open the right-hand side of the Address Book, use the close («) and
open (») buttons.

To move the keyboard focus back and forth between the left and right sides of the
Address Book, press the F6 key.

To move quickly through the tabbed panels on the right side of the Address Book,
use the Ctrl+Tab, Ctrl+PgUp, Ctrl+PgDn, Ctrl+Home, and Ctrl+End keys.

Creating New Entries
To create a new file of Address Book entries, click on New, or right-click
anywhere in the entry list and select New... from the popup menu. A dialog is
displayed asking what you want to call it.
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Creating a new file or entry

Enter a name for the file and select Make it an Address Book, then click OK to
create it. The file is displayed in the list, and you can now add entries to the file.

To create a new entry to be included in an existing file, either click on New in the
Address Book, or right-click anywhere in the entry list and select New... from the
popup menu. A dialog is displayed. Enter a Nickname for the entry. A Nickname
(sometimes called an alias) is an easily remembered, shorter substitute for the e-
mail addresses in the entry. Nicknames can be used in place of proper e-mail
addresses in the To, Cc, and Bcc fields of outgoing messages. For example,
“buddies” may be a nickname that stands for a list of five very complicated e-mail
addresses for five friends of yours. You’ll be sending mail addressed to “buddies”
rather than having to enter those five complicated e-mail addresses in the recipient
fields.

Specify which file this entry belongs in (if you have multiple files), and select the
Put it on the recipient list option if you want the nickname on your recipient list.
You cannot create a file within a file, so do not use the Make it an Address Book
option. Click OK to create the entry. Then you can enter the information for that
entry.

In the Address(es) tab, enter the complete e-mail addresses of the people (or
person) to be included in the nickname, separating the addresses with commas or
returns (this is the only place you can use a return to separate addresses). You can
also use nicknames in this field, but be sure that any nicknames you use are
defined in their own entry. You can use a mix of nicknames and complete e-mail
addresses.
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In the Name field (in the Info tab), enter the real name of the person or group. If
there is just one address for the entry, the real name and the address are included
in the To field for your recipient to see. If there is more than one address for the
entry, the real name is the only thing included in the To field for your recipients—
they do not see the whole list of recipients. If there is nothing in the Name field,
the recipients do see the whole list.

In the other fields provided in the Info (Postal Address, Phone, and Fax) and
Notes tabs, you can enter contact information for the person or group, and any
notes to yourself. This information is not included in outgoing messages.

We recommend that you have at most 2,500 entries per file. If you have a large
number of entries, you may want to consider using a Ph server (for information,
see the “Sources” section of the Eudora Reference Manual).

To save your changes to the Address Book, select Save from the File menu.

Changing, Moving, Copying, and Deleting Entries
To change the nickname for an entry, see “Renaming a Nickname” below.

To make other changes to an entry—that is, to change any information in the
Address(es), Notes, or Info tabs—select the entry from the list and edit the fields
as appropriate.

To move or copy an entry to a file, right-click on it and select the Move To... or
Copy To... command. The Choose a Nickname File dialog is displayed so that
you can select the file you want to move or copy the entry to.

You can move an entry (or entries) to a different file by dragging it, or copy it by
holding down the Shift or Ctrl key and then dragging it.

To delete an entry or an address file, select it from the list and click on the Del
button or press the Delete key. Or, right-click on it and select Delete from the
popup menu. You cannot remove the Eudora Nicknames file.

To save your changes, select Save from the File menu. (Tip: Add a button for the
File menu Save command to your main toolbar as a handy way to save Address
Book changes.)

Renaming a Nickname
To change the nickname for an Address Book entry, first make sure the View By
field is set to Nicknames and that the entry is displayed in the list. Then, click on
the nickname for the entry, pause, and click on it again. You can then edit the
nickname in the edit box.
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Alternately, click on the nickname once to highlight it, then press F2 and edit the
nickname. Or, click on the nickname to highlight it, right-click on the selection to
display the popup menu, select Rename from the menu and edit the nickname in
the edit box.

Including Nicknames on the Quick Recipient List
To include a nickname in the Quick Recipient List, right-click on the appropriate
Address Book entry in the list and select Add to Recipient List from the popup
menu. The nickname for the selected entry is included on the Quick Recipient
List, and the entry is bolded in the Address Book list.

To remove a nickname from the Quick Recipient List, right-click on the item in
the Address Book list and select Remove From Recipient List from the popup
menu. The nickname for the selected entry is removed from the Quick Recipient
List, and the entry is unbolded in the Address Book list.

If you change a nickname, the Quick Recipient List is updated as appropriate. For
details about using the Quick Recipient List, see the section “Using the Quick
Recipient List.”

Addressing a Message from the Address Book
You can open and address a new message from the Address Book using the To,
Cc, and Bcc buttons.

To create a new message from the Address Book, select the entry you want to
address the mail to (hold down the Shift key to select multiple entries in sequence,
or the Ctrl key to make disjoint selections). Then click on To, Cc, or Bcc. A new
composition window is displayed with the selected nickname(s) inserted in the
appropriate field.

To address the message with the completely expanded address or addresses for
that entry, rather than the entry’s nickname (the addresses are listed in the
Address(es) field for the entry), turn on the Expand Nickname option.

Once the composition window is displayed, you can use the To, Cc, and Bcc
buttons to insert additional nicknames into the corresponding fields, subject to the
following restrictions.

If the Address Book is a docked or floating window (either alone or as part of a
tabbed window group), the To, Cc, and Bcc buttons apply to the topmost
composition window, if any. If the Address Book is a normal window (either
alone or as part of a tabbed window group), the To, Cc, and Bcc buttons apply to
the composition window, if any, that is immediately under either the Address
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Book or the tabbed window group containing the Address Book. For more
information on docked, floating, normal, and tabbed windows, see the section
“Managing Your Windows in Eudora.”

The “Make Address Book Entry” Command
The Make Address Book Entry command is used to create entries in your
Address Book, and is especially helpful for making group entries.

In the Address Book, highlight several different entries (hold down the Shift key
to select multiple entries in sequence, or the Ctrl key to make disjoint selections),
then select Make Address Book Entry... from the Special menu. The Make
Address Book Entry dialog is displayed, prompting you for the nickname of the
new entry. The Address(es) field of the new entry will include the nicknames for
the entries you selected, not the real addresses.

Using the “Make Address Book Entry” command from the Address Book

In a mailbox, highlight the message summaries you want and select Make
Address Book Entry... from the Special menu. The Make Address Book Entry
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dialog is displayed, prompting you for the nickname of the new entry. Follow the
instructions for creating a new entry. If the current message is an outgoing
message, the new entry will include all of the addresses in the To, Cc, and Bcc
fields. If the current message is an incoming message, the new entry will include
the address in the From field. If multiple messages are current (i.e., you have
several message summaries selected in a mailbox window), addresses are taken
from each message and are all put in the new entry.

In an open message window, select Make Address Book Entry... from the
Special menu. The Make Address Book Entry dialog is displayed, prompting you
for the nickname of the new entry. Follow the instructions for creating a new
entry. If the open message is an outgoing message, the new entry will include all
of the addresses in the To, Cc, and Bcc fields. If the open message is an incoming
message, the new entry will include the address in the From field. If multiple
messages are open, addresses are taken only from the currently active (topmost)
open message. Also see the note above about the Include yourself option.

In the Directory Services window, finish a query, select in the results list the
target(s) you want to include in the entry, and select Make Address Book
Entry... from the Special menu. The Make Address Book Entry dialog is
displayed so that you can name the nickname. The real name and e-mail address
of each selected target is included in the new entry. See the section “Using
Directory Services” for more details.

The “Finish Address Book Entry” Command
With the Finish Address Book Entry command, you can enter a unique portion
of a nickname in the To, Cc, or Bcc fields of a message, then select Finish
Address Book Entry from the Edit menu, and the nickname will be completed
for you. You must enter the characters in the nickname that make it unique, or
Eudora will not know which nickname to use. For example, if you have two
nicknames, joan and john, you would have to enter “joa” or “joh” for Eudora to
complete them.

To insert the real addresses for the entry, instead of the nickname, hold down the
Shift key and select Finish Address Book Entry from the Edit menu. To set this
to happen all the time, turn on the Automatically expand nicknames option in
the Miscellaneous Options.

Using Central Address Book Files on a Server
You can set up central Address Book files on a server and configure Eudora
clients so that they refer to the central files.
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First, be sure the files are plain text, have a .txt extension, and are formatted as
follows: One nickname on each line with the real addresses separated by commas,
and one line for notes and info with the Notes text following the Info data. For
example:

alias Wow joe@wow.com,lisa@wow.com,chris@wow.com
note Wow <fax: 222.2223><phone: 222.2222><address:1234 Street>

<name:Wow Inc.>My favorite company

Then, for each client application, add an ExtraNicknameDirs entry to the
[Settings] section of the Eudora.ini file. This entry should be followed by the list
of directories that contain Address Book files, separated by semicolons (;). Any
Address Book files located in those directories are added to the Address Book.
Users will need to exit and re-open Eudora to see the new entries.

Using Address Book Files Not Created by Eudora
To use an Address Book file that was not created in Eudora, put the file in the
Nickname directory (in your Eudora directory), and be sure the format is as shown
in the section “Using Central Address Book Files on a Server.” You will need to
exit and reopen Eudora to see your new entries in the Address Book.

Using the Quick Recipient List
The Quick Recipient List is your list of recipients to whom you often send mail.

To add a nickname to the Quick Recipient List, open the Address Book, select the
desired entry in the list on the left by clicking once on the item, right-click on the
item and select Add to Recipient List from the popup menu. The entry’s
nickname is added to the Quick Recipient List and the entry is bolded in the
Address Book list.

To add an e-mail address to the Quick Recipient List, select the text that makes up
the full address. Then, select Add as Recipient from the Special menu.

To remove an entry from the list, open the Address Book, select the desired entry
in the list on the left by clicking once on the item, right-click on the item and
select Remove From Recipient List from the popup menu. The entry’s nickname
is removed from the Quick Recipient List and the entry is unbolded in the
Address Book list. Or, select the item you wish to remove from the Remove
Recipient submenu under the Special menu.
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To open a new message addressed to someone on your Quick Recipient List,
select New Message To, Forward To, or Redirect To from the Message menu,
and select the nickname from the displayed list.

To insert a recipient into a message that you have already opened, put the cursor
where you want the recipient and select the recipient from the Insert Recipient
submenu under the Edit menu.

To insert the real address(es), instead of a nickname, hold down the Shift key and
select the recipient from the Insert Recipient submenu under the Edit menu. To
set this to happen all the time, turn on the Automatically expand nicknames
option in the Miscellaneous Options.

More than one recipient from the Quick Recipient List can be added to the To,
Cc, and Bcc fields of any message. If you use the Insert Recipient submenu,
commas are added where necessary.
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Opening Directory Services
Eudora lets you look individuals up on the Internet, within your company, and in
your Eudora Address Book (if you have one set up) using four directory service
protocols: Ph, Finger, LDAP (Lightweight Directory Access Protocol), and
Eudora Address Book.

To use directory services to look someone up, open the Directory Services
window: select Directory Services from the Tools menu. Or, if the Directory
Services window is an inactive window in a visible tabbed window group, click
its tab. (See “Managing Your Windows in Eudora” for more information on
tabbed windows.)

The Directory Services window, showing a sample query
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The directory service protocols available to you for your search are listed in the
Protocols section of the window. See the section “Directory Service Protocols”
for more information.

The databases you can use to look up your target individual are listed in the
Databases list. For more details, see the sections “Directory Service Databases,”
“Creating a New Database,” “Modifying an Existing Database,” and “Deleting a
Database.”

To resize the left and right halves of the window relative to each other, drag the
vertical separator bar to the left or right.

Keeping the Directory Services Window on Top
To keep the Directory Services window on top so that you can easily continue
using it, turn on the Keep On Top option. Eudora remembers the state of this
option when you quit and restart the program.

Looking Someone Up (Making a Query)
To look someone up on the Internet, within your company, or in your Eudora
Address Book, open the Directory Services window and take these steps:

1. In the Databases list, select the database(s) you want to search in your query.

To select a database, click the checkbox to the left of the database until a
checkmark appears in the box. You can select multiple databases, and you can
use multiple protocols. You must select at least one database in the list in
order for Eudora to perform the query.

2. In the Query field, type a text string you want to search against.

If one or more of your selected databases use a protocol other than Ph, your
entry in this field will always be interpreted as a name. If you only have Ph
servers selected as your databases, you can enter any commands that Ph will
interpret.

3. After you’ve typed the text, start the query by pressing Enter or clicking the
Start button.

The query begins, and the Start button changes to Stop.

4. To stop the query before it is completed, click the Stop button.

When the query is completed, or if you click Stop to cancel the query, the Stop
button changes back to Start.
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Instructions for reading the results of your query appear in the next section.

Reading Your Query Results
Your query results are listed in the left half of the Directory Services window, in
the results list (top view) and the details pane (bottom view). You can resize the
two views relative to each other using the separator between them: drag the
separator up or down.

The results list consists of one-line summaries of the “hits” or successful targets
of your query. These are listed by four columns: Name, Email, Phone, and
Database. Name indicates the username (or other name) of the target. Email is the
e-mail address of the target. Phone is the target’s telephone number. Database tells
you in which of your selected databases the target was found.

Click on a column heading to sort the results list alphabetically (or numerically)
by that column. Shift-click to sort in reverse order.

To resize the columns, drag the divider line to the right of the desired column to
the left or right. Note that the columns resize dynamically during a query, to
accommodate the width of each target’s data.

The Status field displays the status of your query (such as Ready, Connecting,
Getting Data, etc.) and the number of items found as shown in your summary
list. This number is updated dynamically until the query is complete or you stop
it.

If the results list does not fit in the available viewing space, scroll bars appear to
let you navigate through the remaining part of the list.

To view the details of a result in the details pane, select the result in the results list
by clicking once on it. The full data appears in the details pane. If nothing is
selected in the results list, the details pane is blank. If multiple summaries are
selected in the results list, the details pane lists the details for each item, with each
item separated by a divider line.

To select multiple items in the results list, use the Shift key to select a continuous
range, and use the Ctrl key to make disjoint (discontiguous) selections.

Scroll bars appear in the details pane if the displayed information cannot fit in the
viewing space.

QUALCOMM Incorporated 145



Using Directory Services Eudora User Manual

Addressing a Message from the Directory Services Window
You can create and address a message with the query results in the Directory
Services window.

To create a new message, be sure there are no outgoing messages already open,
perform your query, then select one or more summaries in your results list. Now
click on the To, Cc, or Bcc button. A new message is created, and it is addressed
appropriately with the selected query results.

To add an address to an existing message, make sure the message you want to
address is active, open the Directory Services window, perform the query, and
select one or more summaries in the results list. Now click the To, Cc, or Bcc
button. The addresses from the selected query results are added to the appropriate
field of the current message.

Making an Address Book Entry from Your Query Results
You can make a nickname from your query results in the Directory Services
window, and add the entry to your Address Book.

To make a nickname, open the Directory Services window, perform a query, and
select one or more summaries in the results list. Now select Make Address Book
Entry... from the Special menu. The Make Address Book Entry dialog is
displayed so that you can name the nickname. The real name and e-mail address
for each selected query result is included in the new entry.

Printing Your Query Results
You can print, and preview for printing, the results of your query as shown in the
details pane.

First perform your query, then select one or more summaries in the results list.
The details pane lists the details of each selected item, with each item’s details
separated by a divider line.

To preview your query details for printing, select Print Preview from the File
menu. The Print Preview dialog is displayed, showing how the query details will
look when printed.

To print your query details, select Print... from the File menu.
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Window State Considerations
The behavior of some Eudora features internal and external to the Directory
Services window depends on the state of the window. For definitions of window
states, see the section “Managing Your Windows in Eudora.”

When the Directory Services window is in the docked or floating state (either
alone or as part of a tabbed window group), the following applies:

• The Keep on top setting in the window is ignored.

• The To, Cc, and Bcc buttons in the window apply to the topmost composition
window, if any.

• The Special menu Make Address Book Entry... command, and the File menu
Print Preview and Print... commands, apply to the Directory Services window
only if the keyboard focus is in that window.

When the Directory Services window is in the normal state (either alone or as part
of a tabbed window group), the following applies:

• The Keep on top setting in the window is obeyed.

• The To, Cc, and Bcc buttons in the window apply to the composition window,
if any, immediately under the Directory Services window or the tabbed window
containing it.

• The Special menu Make Address Book Entry... command, and the File menu
Print Preview and Print... commands, apply to the Directory Services window
only if it is the topmost normal window and is active, or if the tabbed window
containing it is the topmost normal window and the Directory Services tab is
active.

Directory Service Protocols
The Protocols section of the Directory Services window lists the directory service
protocols available to you that you can use when creating and modifying
databases for looking up individuals via these services.

Eudora comes with four protocols installed by default: Ph, Finger, LDAP
(Lightweight Directory Access Protocol), and Eudora Address Book.

Click on the column heading (Registered Drivers) to sort the protocols
alphabetically. Shift-click on the column heading to sort in reverse order.
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You can resize the column by dragging the divider line to the right of the column
heading to the left or right.

The use of the New Database... button, shown in this section of the window, is
described under “Creating a New Database.”

Directory Service Databases
The Databases section of the Directory Services window lists the databases that
are available to you for searching for individuals over the Internet, within your
company, or in your Address Book (if one is set up).

Eudora comes with these servers already configured by default:

• ldap.bigfoot.com

• ldap.switchboard.com

• ldap.whowhere.com

• ldap.infospace.com

• ldapbiz.infospace.com

• ldap.four11.com

• Eudora Nicknames [or the name of your nicknames file: this last item appears
only if you have a Eudora Address Book set up]

You can modify or delete these databases, and you can also create new databases
and modify and delete them. See the sections below for more information.

You use the databases in this list to perform your lookup queries. To perform a
query, you must first select one or more databases in the list. To select a database,
click on the checkbox to the left of the database name, until a checkmark appears
in the box. If no databases are selected, you cannot perform a query.

You can select multiple databases to perform a query, and you can mix protocols.

Click on a column heading to sort this list by that column, alphabetically. Shift-
click on the column heading to sort in reverse order.

To resize columns, position the mouse pointer over the divider line to the right of
the desired column, and drag the line to the left or right.
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The use of the Modify... button in this section of the window is described in
“Modifying an Existing Database.” The use of the Delete button is described in
“Deleting a Database.”

Creating a New Database
In addition to the default directory service databases that already come configured
with Eudora, you can create new Ph, Finger, and LDAP databases for your
Directory Services queries. Databases are created from the Protocols section of
the window, and they must be created using one of these three listed protocols.

To create a new database, click on the desired protocol in the Protocols list to
select it, then click the New Database... button. Or, just double-click on the
protocol in the Protocols list. The New Database dialog is displayed. This dialog
will differ depending on the protocol you’ve selected.

Fill out the fields of the dialog and click OK to save your entries and close the
dialog, or click Apply to save your entries without closing the dialog. The new
database is added to the Databases list and is given a checkbox so that you can
select the database for a query. If you chose to Apply, the dialog remains open
and you can make additional changes.

For a Ph database: In the General panel, enter the Server name, the Host name,
and the Port. In the Attributes panel, click Add... to add an attribute to the
attributes list. Attributes determine what is listed in the columns of the results list,
and must be tied to a valid attribute name, corresponding to one of the column
headings in the results list. To edit an attribute, click on the attribute in the list and
click the Edit button, then edit the attribute name. To remove an attribute, click
on it to select it and then click the Remove button. When you are finished making
entries to the New Database dialog, click OK to create your new Ph database. The
database is added to the Databases list with its checkbox.

For a Finger database: Enter the Server name, the Host name, and the Port in
the General panel, then click OK to create the new Finger database.

For an LDAP database: In the Network panel, enter the Server name, the Host
Name, and the Port. If you turn on the This server requires me to log on option,
then enter an Account name and a Password. In the Attributes panel, add, edit,
or remove attributes using the buttons. Attributes determine how your query
results are listed in the results list. Key the attributes to the column heading names
in the results list. In the Search Options panel, specify the Search timeout, the
Maximum number of matches to return (or turn on the No Limit option to
specify unlimited matches), and the Search Base. In the Log panel, specify
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whether you want to generate log files and if so, how to store them: specify
whether you want to enable logs for Protocol interactions and/or a
Configuration data load/store; enter a Log file name or select one using the
Browse... button; and turn on the Overwrite existing log file option if you want
new logs to replace the old ones. When all your information is entered in the New
Database dialog, click OK and your new LDAP database is created with its
checkbox.

Modifying an Existing Database
You can modify any Ph, Finger, or LDAP database in your Databases list.

To modify an existing database, click on the database name or icon in the
Databases list to select it, then click the Modify... button. Or, just double-click on
the database in the list. The Modify Database dialog is displayed, with its fields
pre-filled in with the information from the selected database.

Make your changes in the Modify Database dialog and click OK to save the
changes and close the dialog, or click Apply to save the changes and leave the
dialog open. You can then make additional changes and save or discard them.

The Modify Database dialog will differ depending on the protocol you’ve
selected. For details on the fields of the different dialogs, see the section “Creating
a New Database.”

Deleting a Database
To delete a database, click on the database name or icon in the Databases list to
highlight the item, then click the Delete button. You are prompted to confirm the
delete. Click Yes and the database is removed from the list. Click No and the
deletion is cancelled, and the database remains.

You can delete multiple databases at once: use the Shift key to select a range in
the list, and use the Ctrl key to select items disjointly.
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Clear button 41 Date column 74
Delete button 41 Date Display Options 74, 97

Spelling Options dialog 42 Date formatting 74
Ignore capitalized words 42 Decoding attachments 37
Ignore words with all capitals 42 Default Domain option 132
Ignore words with mixed case 42 Default Signature option 132
Ignore words with numbers 42 Default Stationery option 132
Report doubled words 42 Delete all messages on server option 60
Suggest words 43 Delete all messages that have been retrieved option

60Choose a Nickname File dialog 140
Clear Formatting button 22 Delete attachments when emptying Trash option 84
Clear Formatting command 34 Delete button 153
Clock icon, in the Status column 47, 73 Delete command 62, 83
Close button, in a docked window 109 Delete from server after ? days option 57, 134
Color button 21 Delete From Server button 54
Color submenu 34 Delete from server when emptied from Trash

option 60, 134Compact
all mailboxes 76 Delete messages marked for deletion option 59
one mailbox 76 Delete server status 58, 75, 96

Compact Mailboxes command 76 Deleting mail
Composition window 19 fromthe IMAP server 62
Configuration option 134 Detaching attachment 36
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contains option 93 Directory Services
Context menu, for tool windows 115 addressing a message from 150
Context Sensitive Help command 17 Bcc button 150
Copy & Unwrap command (Shift-Copy) 35 Cc button 150
Copy blind creating a new database 153

with Bcc field 23 Databases list 148, 152
with Name field in Address Book 140 default databases 152

Copy original’s priority to reply option 31, 66 deleting a database 155
Copy To action 96 Keep On Top option 148
Copy To command 140 looking someone up 148
Copying a message to a mailbox 24, 84 making a nickname from 150
Creating a new tabbed window 114 making a query 148

modifying an existing database 154
previewing query details for printing 150

D printing query details 150
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Query field 148creating 153
reading your query results 149deleting 155
Registered Drivers column 152modifying 154
Start button 148Databases list 148, 152
Status field 149Databases, default (Directory Services) 152
Stop button 149
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To button 150 Warn me when I Queue a message with styled
text option 33window state considerations 151

Directory Services command 147
Directory Services window 147

FDiscard styles before sending messages option 33
Display Options 75 Fax field 140

Show MDI task bar option 118 Fcc menu 24, 48
Docked windows 107 Fetch all message headers to In mailbox option 60

close button 109 Fetch button 54, 58
gripper bar 108 Fetch server status 58, 75, 96
resize bar 109 Fetch then Delete server status 58, 75
zoom button 108 File Browser command 120
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turning on 116 Filter icons 92

doesn’t appear option 93 Filter Messages command 88, 91
doesn’t contain option 93 Filter Report command 119
Dominant personality 131 Filter Report window 95, 119
Don’t send option 47 Filtering messages 85
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appears option 93
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Edit contains option 93
incoming mail 56 Copy To action 96
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Encoding methods Forward To action 96
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Enter Selection command 100 is not option 93
Eudora Address Book protocol 147 is option 93
Eudora taskbar 117 Make Label action 95
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Exit command 17 Make Status action 94
Exiting Eudora 17 Make Subject action 95
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Extra Warnings Options 45 Match Type popup 93
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None action 94 Forward To action 96
Notify Application action 95 Forward To submenu 146
Notify User action 95 Forwarded status (right arrow) 67
Open action 95 From field
or option 94 in a forwarded message 67
Outgoing option 91 in Filters 92
Play Sound action 95 in outgoing mail 23
Print action 95 in redirected message 67
re-ordering 92
Redirect To action 96

GReply with action 96
Server Options action 96 Generate Filter Report option 119
Skip Rest action 96 Generic Properties tab 130
starts with option 93 Getting Attention Options
Transfer To action 96 and Notify User filter action 95
unless option 94 Generate Filter Report option 119

Filters command 90 Open mailbox option 52
Filters window 90 Play a sound option 52
Find 98 Use an alert dialog box option 52

Match case option 99 Getting Started Options
Multiple messages 99 Mail Server (Incoming) option 49
Next button 99 Gripper bar, in a docked window 108
Next mailbox button 99 Guess Paragraphs option 101
Next message button 99
Stopping 100

HSummaries only option 100
Within a message 98 Help button 17

Find Again command 99 Help menu
Find button 98, 99 Tip of the Day 17
Finger protocol 147 Help with Eudora 17
Finish Address Book Entry command 144 Hide command 116
Fixed Width button 53 Hide the recipient list
Float In Main Window command 106, 108, 110,
114, 116, 117

with Bcc field 23
with Name field in Address Book 140

Floating windows 109 Hiding tabbed/tool windows 116
Font popup 21 Horizontal lines
Font submenu 34 inserting in outgoing message text 35
Forget Password(s) command 51 Hot link
Formatting text 33 in outgoing mail 37

Copy & Unwrap 35 Hot links
Discard styles before sending messages option
33

in incoming mail 57
How should checking/sending be performed option
60Unwrap Selection 35

Wrap Selection 35
Forward command 67
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Hyperlink Inline spell checking 43
in outgoing mail 38 Insert Horizontal Line command 35

Hyperlinking text and graphics 34 Insert Object button 22, 35
Insert Picture command 35
Insert Recipient submenu 146

I Insert submenu 35
Inserting objects in outgoing message text 35Icons
Installation 11filters 92
Intercept Netscape mailto URLs option 57ignore option 94
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Internet Message Access Protocol 15IMAP 15
intersects nickname option 93IMAP Mailbox Location Prefix option 135
is not option 93IMAP option 134
is option 93IMAP server
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Immediate send option 45, 46
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Include Headers option 101 Keep copies option 48
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Incoming Mail Options 57 Keep On Top option 148

Delete from server when emptied from Trash
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Keyboard focus 17
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Incoming Mail tab 134 LDAP protocol 147
Incoming message window Leave mail on server option 57, 58, 134
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BLAH BLAH BLAH button 53 Left command 34, 116
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Priority popup 54
Retrieve From Server (Fetch) button 54

MSubject field 54
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Incoming option 91 creating during transfer 85
Indent In button 22 creating in the Mailboxes window 80
Indent Out button 22 creating using Mailbox menu 78
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management on POP vs. IMAP server 81 with multiple recipients 139
New command 78, 80 Make Address Book Entry command 142, 143,

144, 150removing in the Mailboxes window 80
renaming in Mailboxes window 80 from a mailbox 143

Mail storage from Directory Services 144, 150
POP and IMAP servers 81 from open message window 144

Mail Transfer Options dialog 48, 57, 58, 75 from the Address Book 142
Delete all messages on server 60 Make Filter command 86
Delete all messages that have been retrieved
60

Make Filter dialog 86
Make Hyperlink button 22

Delete messages marked for deletion 59 Make Hyperlink command 34, 38
Fetch all message headers to In mailbox 60 Make it a folder option 78, 80
How should checking/sending be performed
60

Make it an Address Book option 139
Make Label action 95

Retrieve messages marked for retrieval option
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Make Priority action 94

Retrieve new mail 59 Make Status action 94
Send queued messages 59 Make Subject action 95

Mailboxes Managing mail on the IMAP server 61
compacting all 76 Delete command 62
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creating during transfer 85 refreshing the mailbox list 63
creating in the Mailboxes window 80 Remove Deleted Messages command 62
creating using Mailbox menu 78 resynchronizing a mailbox or folder 62
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Make it a folder option 78 UnDelete command 62
management on POP vs. IMAP server 81 Managing mail on the POP server
message summaries 72 Delete from server when emptied from Trash

option 60moving in the Mailboxes window 80
New command 78, 80 Delete server status 58, 75
number of messages 76 Fetch button 58
opening 71 Fetch server status 58, 75
removing in the Mailboxes window 80 Fetch then Delete server status 58, 75
renaming in the Mailboxes window 80 Leave mail on server option 57
resizing columns 75 Leave server status 75
size display 76 Mail Transfer Options dialog 58
sorting messages in 97 Skip messages over ? K in size option 58
space messages require 76 Trash button 58
space wasted 76 Managing your windows in Eudora 103
transferring messages among 84 Manual option 91

Mailboxes command 79 Map Ctrl+R to “Reply to All” option 66
Mailboxes window 79 Margins submenu 34
Mailing lists Mark previewed messages as read after ? second(s)

option 77creating a nickname 138
hiding the recipient list 140 Match case option 99
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“me” nickname, for personal identification 69 Multiple recipients
Menu, context creating a mailing list 138

for tool windows 115 hiding the recipient list 140
Message body

in incoming mail 54
Nin outgoing mail 24

Message header Name field 140
in incoming mail 54 New Account Wizard 14
in outgoing mail 23 New button in Address Book 138, 139

Message Options dialog 25 New button in Filters window 91
Message preview pane 52, 76 New command 78, 85
Message priority New Database button 152, 153

how to set 31 New Mailbox dialog 78, 85
Message summaries 72 New Message command 19

Attachments column 74 New Message To submenu 146
changing the subject of 56 Next button 99
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Priority column 73 Next Mailbox command 99
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selecting 72 Next Message command 99
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Server Status column 75 Nicknames 139
Size column 74 “me” 69
Status column 73 adding to the Quick Recipient List 141
Subject column 75 creating in the Address Book 138, 139
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MIME encoding 36 renaming 141
Minimal Headers Only option 61, 135 None action 94
Miscellaneous Options Normal windows 105

Allow drag and drop transfers option 85 and taskbar 118
Automatically expand nicknames option 144,
146
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Notify Application action 95

Discard styles before sending messages option
33

Notify User action 95

Empty Trash when exiting option 83
OIntercept Netscape mailto URLs option 57

Turbo redirect by default option 68 On or after option 47
Modify button 153, 154 Online help 17
Move To command 140 Open action 95
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Outgoing message window P
Message body 24

PasswordMessage header 23
changing 51Attached field 24
entering 50Bcc field 23
forgetting 51Cc field 23
remembering 51From field 23
Saving 51Subject field 23

Pencil button 54To field 23
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Personalities command 127Toolbar 20
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Personality Name field 131Attachment Type popup 20
Ph protocol 147Bold button 21
Phone field 140Bulleted List button 22
PicturesClear Formatting button 22

inserting in outgoing message text 35Color button 21
Plain command 33Font popup 21
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POP 15Insert Object button 22
POP option 134Italics button 21
POP server 57Keep Copy button 21
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Print commandSend button 21
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Q, in the Status column 45, 47, 73 Real Name option 131
Query field 148 Redirect
Query results (Directory Services) 149 automatically put new message in the queue 68
Queue button 21, 45, 46 no signature 69
Queue For Delivery command 45 Turbo redirect by default option 68
Queue mail 45 Redirect command 67

Change Queueing command 46, 47 Redirect To action 96
Change Queueing dialog 46 Redirect To submenu 68, 146
Don’t send option 47 Redirected status (diagonal arrow) 68
editing before sending 47 Refresh command 123
for a certain time 46 Refresh Mailbox List command 63, 81
Immediate send option 45 Register Eudora command 18
Next time queued messages are sent option 47 Registered Drivers column 152
On or after option 47 Registration 18
Queue button 45 Rejected mail 69
Queue For Delivery command 45 Remove Deleted Messages command 62, 83
Right now option 47 Remove From Recipient List command 141, 145
Send Message Right now option 46 Remove Recipient submenu 146
Send Queued Messages command 46 Rename command 80, 141
sending queued mail when checking mail 47 Renaming a mail folder 80
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Quick Recipient List 145 Reply

Add to Recipient List command 145 Copy original’s priority to reply option 66
Adding e-mail address to 145 in a filter with stationery 28
Forward To submenu 146 Include yourself option 65
Insert & Expand Recipient submenu 146 Map Ctrl+R to “Reply to All” option 66
Insert Recipient submenu 146 Put original To recipients in Cc field option 66
New Message To submenu 146 quoting original text 65
putting nicknames in 141 Reply command 65
Redirect To submenu 146 with stationery 28, 66
Remove From Recipient List command 145 Reply command 65
removing nicknames from 141 Reply to All command 66
Removing recipient from 145 Reply with action 96

Quitting Eudora 17 Reply With submenu 66
Quoted text Reply-To field

in replies 65 in Filters 92
with styles in replies 65 Replying Options

Quoted-Printable button 20 Copy original’s priority to reply 31
Copy original’s priority to reply option 66
Include yourself 65
Map Ctrl+R to “Reply to All” option 66
Put original To recipients in Cc field option 66
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Requirements 11 Sendable (•) status 43, 47
Resize bar, in a docked window 109 Sender/Recipient (Who) column 74
Resynchronize Mailbox command 63, 81 Sending Mail Options
Retrieve From Server (Fetch) button 54 Immediate send option 45
Retrieve messages marked for retrieval option 59 Keep copies option 48
Retrieve new mail option 59 Send on check 47
Retrieve only message headers 60 SMTP server option 16
Return Address option 131 Sent (√) status 48
Return Receipt button 21, 32 Server option 134
Right arrow, in the Status column 67, 73 Server Options action 96
Right command 34, 116 Server Status column 75
Right now option 47 Server status popup 58

Shift+Check Spelling shortcut
inline spell check 43

S Shift+Space 77
Shift+Space modifierSave As command 37, 101

change to Read or Unread status 73Save As Stationery command 27, 124
Show attachment icons option 54, 55, 62Save command 43, 140, 141
Show mailbox lines option 73Save mail as text
Show MDI task bar option 118as a single file 101
Show message preview pane option 76Guess Paragraphs option 101
Show Single Tab command 114, 116Include Headers option 101
Show Tips at Startup option 17Save password option 51
SidebarsSaving messages 43

in quoted text with styles 65Send Again command 69
Signature popup 20Send button 21, 45
Signature window 125Send Immediately command 45
SignaturesSend mail

and redirect 69all at once 45
and stationery 30at a certain time 46
changing 29Change Queueing dialog 45
creating 29Immediate send option 45, 46
deleting 30Mail Transfer Options dialog 48
including in a message 30replies 65
including in all messages 30Send button 45

Signatures command 125Send Immediately command 45
Simple Mail Transfer Protocol 16Send Message Right now option 46
Size button 21Send Queued Messages command 46, 48
Size column 74sending queued mail when checking mail 47
Size submenu 34with server instructions 48
Skip Attachments over ? K option 61, 135Send Message Right now option 46
Skip messages over ? K in size option 58, 134Send on check option 47
Skip Rest action 96Send Queued Messages command 46, 48
SMTP 16Send queued messages option 59
SMTP server field 16
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SMTP Server option 132 T
Sort submenu 97

Tab keySorting 97
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Tab Location submenu 114, 116Sorting in descending order 97
Tabbed windows 103, 111Spacebar 52

and taskbar 118Spell checking 38
closing 115inline 43
creating 114Spell Checking Options 38
default 112Start button 148
opening and activating 113starts with option 93
reorganizing 113Stationery command 124
tab display 114Stationery messages

Tabschanging 28
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Tabs, windowsopening 28
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location 114Status
showing and hiding 114-, never sent 73

Taskbar buttons 117<blank>, read or unsendable 73
Taskbar, Eudora 117clock icon, timed 47, 73
Technical support 18diagonal arrow, redirected 68, 73
Technical Support command 18left arrow, replied 65, 73
Text As Attachment button 20, 36Q, queued 45, 47, 73
Text submenu 33right arrow, forwarded 67, 73
Timed status (clock icon) 47•, sendable or unread 43, 47, 52, 73
Tip of the Day 17√, sent 48, 73
Title barStatus column 73

for incoming mail 53Status field, of Directory Services 149
for outgoing mail 19Stop button 149

To buttonSubject column 75
in Directory Services 150Subject field
in the Address Book 141changing in message summaries 56
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Tool window management 103Summaries only option 100
Tool windows 103System requirements 11

new 119
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View By option 138in outgoing mail 20
Viewing Mail Options 54Top command 116

Mark previewed messages as read after ?
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Show attachment icons option 54, 55Traits section 131
Show message preview pane option 76Transfer To action 96
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transferring a copy 84

Warn me when I Queue a message with styled text
option 33

using the Transfer menu 84
Transferring mail to the Out mailbox 84

WarningsTrash button 58
Try to delete unread, queued, or unsent mail 83Trash mailbox 48, 83

Who column 74Try to delete unread, queued, or unsent mail 83
Window context menu 115Turbo redirect by default option 68
Window management 103Typewriter button 21
Window states 103Typewriter command 34
Window tabs

auto-activation 114
U contents 114

location 114UnDelete command 62, 83
showing and hiding 114Underline button 21

WindowsUnderline command 33
docked 107unless option 94
floating 109Unqualified name, adding domain 132
normal 105Unread (•) status 52
tabbed 103, 111Unwrap Selection command (Shift-Wrap

Selection) 35 Word Wrap button 20, 35
Wrap Selection command 35URL
Wrapped text 20, 35in outgoing mail 37

URLs
in incoming mail 57 Z

Use an alert dialog box option 52
Zoom button, in a docked window 108Use Directory button 55

Use Microsoft’s viewer option 54
User Code 13
Uuencode encoding 36

QUALCOMM Incorporated 163


